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FOREWORD

Since its establishment in 1976, Acharya Nagarjuna University has been forging ahead in the path
of progress and dynamism, offering a variety of courses and research contributions. I am extremely
happy that by gaining a B++ (80-85) grade from the NAAC in the year 2003, the Acharya
Nagarjuna University is offering educational opportunities at the UG, PG levels apart from
research degrees to students from over 285 affiliated colleges spread over the three districts of
Guntur. Krishna and Prakasam.

The University has also started the Centre for Distance Education with the aim to bring
higher education within reach of all. The centre will be a great help to those who cannot join in
colleges, those who cannot afford the exorbitant fees as regular students, and even housewives
desirous of pursuing higher studies. With the goal of brining education to the doorstep of all such
people, Acharya Nagarjuna University has started offering B.A., and B.Com courses at the Degree
level and MA., MCom., MSc., MB.A., and L.L.M, courses at the PG levelfrom the academic year
2003-1004 onwards.

To facilitate easier understanding by students studying through the distance mode, these
se/j-in$truction materials have been prepared by eminent and experienced teachers. The lessons
have been drafted with great care and expertise in the stipulated time by these teachers.
Constructive ideas and scholarly suggestions are welcome from students and teachers involved
respectively. Such ideas will be incorporated for the greater efficacy of this distance mode of
education. For clarification of doubts and feedback, weekly classes and contact classes will be
arranged at the UG and PG levels respectively.

It is my aim that students getting higher education through the centre for Distance
Education should improve their qualification, have better employment opportunities and in tum
facilitate the country's progress. It is my fond desire that in the years to come, the Centre for
.Distance Education will go from strength to strength in the form of new courses and by catering to
larger number of people. My congratulations to all the Directors, Academic Coordinators, Editors
and Lesson-writers of the Centre who have helped in these endeavours.

Prof. P. Rajasekhar
Vice-Chancellor

Acharya Nagarjuna University
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B.Com. Degree Examination, May 2008.
(Examinatipn at the end of Second Year)

Part - II : Commerce

Paper - II : COMPUTER BASED DOCUMENTATION

Max. Marks: 100Marks
Part - A ( 3 X 20 = 60 Marks)
Answer any three Questions

Explain various views available in MS-Word ..

MS - Word ;6oGSJv~g~~ :>:>0 ~gv;6,) :>~eo~~

What is a macro? How do you record, edit and run a macro?

;.....i>'t tIl;6IT';$~? ~g't;6,) !:l:>~ ~V" eS"'~, ~e.~~eo:m oS ~~~?

What are various commands available in 'insert' menu of MS-Word?

M.S. Word ;6oGSJ'~S~g3Ji6.J;6oGSJv~S~~ :>:>0 ~~o~ ~:>?

Explain the process involved in creating envelops in MS-Word.

M.S. Word ;6oGSJ~;6.sv:';vi6.J ~~o~e.JeS" Kv l!J~oi:l;6,) :>~eo~~.

Discuss the process of creation of PPT files.

PPT 1?~;6,)~~o~e.JeS"Kv l!J~oi:l;6,) ~e.J0~~'

Explain the elements of task pane that appears when you press 'new' command in File
menu of MS-Power Point.

MS j~o o)oQ.lJO~ cfuJ~ ~6 3J;6,)eS"~';6"og'~~05 cS"§(,.;6~ei:le~jei:l tJ-~(,. "!>l5cfuJ~(,. eo-t~v;6,)

Part - B (5 X 6 = 30 Marks)
Answer any Five Questions

Nhat are the parts of the MS-Word window?

M.S. Word :Joe? cfuJ~(,.~K~v.J ~:J?

Write the file extensions for the following documents.
a) MS-Word b) Bitmap
c) MS-Excel d) MS-Power Point
e) MS-Access f) MS-Word template.

-:,J ~oe j~~v cfuJ~lr ~6 ~s.)t.j~vi6.J ~o:m~.

a) MS-Word b) £J~ ~g:';

c) MS-Excel

e) MS- O'SJos.)~

d) MS- sss ~Q.lJO~

f) MS-Word ~0~e5"
M



9. How do you give the borders and shading for the tables in MS-word?

M.S. Word ~o~ lje.»~~ t:J9~~ ~O~ ~oo~t)~ !>Jl:S:J .J~ 'C!I~l:S:J?

10. Explain the process of defining bookmarks.

~f ~~lrt)~ :JcS.)~o~t>~:J ~~~~ ~:50o~~.

11. Explain the elements of slide layout command.
~5 0 e~~ ~~o5 d'b:l~lr eo4'~t)~ ~:50o~~.

12. Write a brief note on paste and paste special in MS-Power Point.
MS-Power point ~o~KC) ~~ ~o~ ~~ 1.>.)~6t)~o o~.J.~t:S~ l!7~~.

13. How do you run slide transition in MS-pqwerpoint?
MS-Power point ~o~ 12' ~~~~~ !>Jl:S:J .J~ es Q~l:S:J?

Part - C (5 X 2 = 10Marks)
Answer any Five Questions

14. Drop cap
~:5 S"'b:5

15. Page break
~c2 ~§"

16. Wizards
~2r§

. 17. Folder creation

q'}'~5~~

18. Insert chart command in PowerPoint
~:55 0700JO~~o~Kt) ''C!I~.)§ Q"[ ~~o5.

19. Paragraph alignment options in Power Point.
;.)~5 0700JO~~O~~t) ~~l0"~t) e~~~o~.

20. Diagram Gallery.
Gia'iJ'al0"~~bC}O.
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IComputer Based Documentation 1.1 Basic Concepts

Lesson 1:
Basic Concepts

1.0 Objectives:
The objective of this lesson is primarily to define what a computer is and to give a brief

insight into the evolution of computer, its types and the use of computer in our regular life. After the
completion of this lesson the student will be able to understand:

• What a computer is.
• Characteristics and limitations of a Computer.
• History of Computers.
• The evolution of Computer through five generations.
• Types of Computers.
• Advantages of using Computers.
• Applications of Computers.

Structure of the Lesson:

1.1. Introduction
1.2. What is a Computer?

1.3. Characteristics of a computer
1.4. Limitations of a computer

1.5. Major components of a computer

1.6. History of Computers
1.7. Computer Generations

1.8. Types of Computers

1.9. Advantage. of Computer

1.10. Applications of Computers

1.11. Summary
1.12. Technical Terms
1.13. Model Questions
1.14. References
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1. 1. Introduction:

We are living in an information age. Every type of job relies upon getting information, using it,
managing it, and relaying information to others. Computers enable the efficient processing and
storage of information. The information processed by the computer becomes digital. So Computers
are directly responsible for the smooth running of this information age Computers are placed
everywhere we look, and even in places we can't see. Computers check out our groceries, book
tickets for our journey, fill fuel in our vehicles, dispense money at the ATM, turn the heat on and off,
and control the way our car runs. They're everywhere!

The word "Computer" is derived from the word "COMPUTE", which means to calculate.

Before learning more about computers it is suggested that one should have a basic idea of what
data, information and instruction is.

Data:
Facts, symbols, names, numbers or anything, which has a little meaning, is called as Data. Ex:
hanuman, 123, ramu, 10:50 etc.

Information:
Processed data is known as information.

Instruction:
Instruction is a command, which operates on the stored data.

1.2.What is a Computer?
Computer is an electronic device, which takes data as input, processes it and produces information
as output.

1.3. Characteristics of a Computer:
Computers are becoming popular day by day because of their continuously increasing power and
its usefulness. The following are some of its characteristics.

Accuracy:
Computers always produce correct calculations. If mistake occurs in any calculation, they are due
to human errors like entering wrong data or incorrect instruction.

Speed:
Computers can carry out instructions in less than one millionth of a second.
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Versatility:
Computer can perform any type of work.

Storage capacity:
Computers have the capability to store large amounts of instructions and data. When we ask for
data it supplies the stored information to us.

Repetitiveness:
Computers are capable of performing any task given to them repeatedly.

1.4. Limitations of Computers:

Lack of Commonsense:
Computer is only a tool. It cannot think. It does not have commonsense or intelligence of its own.
Computer acts like a human upto some extent.

Inability to correct:
A computer cannot correct wrong instructions by itself.

Dependence on human instructions:
A computer cannot generate any information on it's own. We must give the correct instructions.

1.5. Ma;or components of a computer:
A System is defined as a set of interacting elements, responding to inputs so as to produce outputs.
The computer system consists of the following elements:

Hardware:
The physical components of a computer system are called as hardware. i.e. components, which
can be seen and touched. It includes input devices, output devices, electronic circuits, capacitors
etc.

The following are some of the hardware components.

ScannerFloppy Disk

Software:
A program or a collection of programs is known as software. Program is a sequence of instructions
designed to direct a computer to perform certain tasks.

Note: A floppy disk is a hardware, but contains a program stored on it, which is a software.
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1.6. History of Computers:
History of computer could be traced back to the effort of man to count large numbers.

Computer history starts with the development of a device called ABACUS by Chinese around 3000
BC. This device was used for counting.

Calculating Machines:

It took over generations for early man to build mechanical devices for counting
large numbers. The Egyptian and Chinese people developed the first calculating
device called ABACUS. The word ABACUS means calculating board. It has a
number of horizontal bars each having ten beads. Horizontal bars represent units,
tens, hundreds, etc.

Napier's Bones:

In the early 1600's, a Scottish mathematician called John Napier invented a tool called Napier's
Bones, which were multiplication tables inscribed on strips of wood or bone. He also invented
logarithms, which is a technology that allows multiplication to be performed via addition.

Slide Rule:
English mathematician Edmund Gunter developed the slide rule. This machine could perform
operations like addition, subtraction, multiplication and division. It was widely used in Europe in 16th

century.

Pascal's Adding and Subtracting Machine:
The mechanical adding machine was invented by a 19 year old French boy named Blaise Pascal
way back in the year 1642. This machine could perform addition and subtraction. The machine
consisted of wheels, gears and cylinders.

Leibniz's Multiplication and Dividing Machine:
Blaise Pascal machine was further improved by Gottfried Wilhelm von Leibniz, a German
mathematician to perform all four arithmetic operations . This machine could perform both
multiplication and division.

Babbage's Analytical Engine:

It was in the year 1823, a famous English man Charles Babbage
designed a mechanical computing machine to do complex
mathematical calculations. It was called difference engine. Later he
developed a general-purpose calculating machine called analytical
engine. Charles Babbage is called the father of computer.
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Augusta Ada Byron -Countess of Lovelace:

In the year 1842, Ada Lovelace with her set of instructions became the pioneer of modern
programming languages and historians have accorded her the status of world's first computer
programmer.

Mechanical and Electrical Calculator:
In the beginning of 19th century the mechanical calculator was developed to perform all sorts of
mathematical calculations. It was widely upto 1960s. Later the rotating part of mechanical calculator
was replaced by electric motor. So it was called the electrical calculator.

Modern Electronic Calculator:
The electronic calculator used in 1960s was run with vacuum tubes, which was quite bulky. Later it
was replaced with transistors and as a result the size of calculators became too small. The modern
electronic calculator can compute all kinds of mathematical computations and mathematical
functions. It can also be used to store some data permanently. Some calculators have in-built
programs to perform some complicated calculations.

1.7. Computer Generations:

The evolution of computer started from 16th century and resulted in the form that we see
today. This period, during which the evolution of computer took place, can be divided into five distinct
phases known as Generations of Computers. Each phase is distinguished from others on the basis of
the type of technology used.

First Generation (Period 1951- 58):
First generation computers used Thermion valves or Vacuum tubes for circuitry, magnetic drums
for memory, and were often enormous, occupying entire room. They were very expensive to
operate and in addition to using a great deal of electricity, generated a lot of heat, which was often
the cause of malfunctions. First generation computers relied on machine language to perform
operations and could only solve one problem at a time. Input was based on punched cards and
paper tape, and output was printed on paper (printouts).

Some of the computers of this generation were: UNIVAC,ENIAC, EDVAC, EDSAC.

Second Generation (Period 1959-64):
With the invention of the Transistor at Bell labs in 1947 by Wiliam Shockley, John Bardeen and
Walter Brattain, it became clear that transistors would replace vacuum tubes. Transistors are smaller
than vacuum tubes and have higher operating speed, more reliable, used less energy and generated
less heat. Thus the size of the computer got reduced considerably. The transistor was invited into
Second-qeneration, computers moved from binary machine language to symbolic or assembly
language. This allowed programmers to specify instructions in words. High-level programming
languages were also being developed at this time. These were also the first computers that stored
their instructions in their memory, which moved from a magnetic drum to magnetic core technology. It
is in the second generation that the concept of Central Processing Unit (CPU), memory,
programming language, input and output units were developed. The programming languages such as



Centre for Distance Education 1.6 Acharya Nagarjuna University

COBOL, FORTRAN were developed during this period. Some of the computers of the Second
Generation were IBM 1620, IBM 1401, CDC 3600.

Third Generation (1965 to 1970):

The third generation computers were introduced in 1964. They used Integrated Circuits (IC's).
These IC's are popularly known as Chips. Transistors were miniaturized and placed on silicon
chips, called semiconductors, which drastically increased the speed and efficiency of computers. A
single IC has many transistors, registers and capacitors built on a single thin slice of silicon. So it is
quite obvious that the size of the computer got further reduced. Instead of punched cards and
printouts, users interacted with third generation computers through keyboards and monitors
interfaced with an operating system. Operating system allowed the device to run many different
applications at one time with a central program that monitored the memory. Computers of these
generations were small in size, low cost, large memory and processing speed is very high. High­
level language such as BASIC (Beginners All purpose Symbolic Instruction Code) was developed
during this period.

Some of the computers developed during this period were IBM-360, ICL-1900, IBM-370, and VAX-
750.

Fourth Generation (1971 to present):
With the invention of the microprocessor, thousands of integrated circuits were built onto a single
silicon chip. The present day computers that we see today are the fourth generation computers that
started around 1975. It uses large scale Integrated Circuits (LSIC) built on a single silicon chip
called microprocessor. Due to the development of microprocessor it is possible to place computer's
central processing unit (CPU) on single chip. These computers are called microcomputers. Later
vel}' large scale Integrated Circuits (VLSIC) replaced LSICs.

In 1981 IBM introduced its first personal computer for the home user, and in 1984 Apple introduced
the Macintosh. Microprocessors moved out of the realm of desktop computers into many areas of
life as more and more everyday products began to use microprocessors.

As these small computers became more powerful, they were linked together to form networks,
which eventually led to the development of the Internet. Fourth generation computers also saw the
development of GUls(Graphical User Interface), the mouse and handheld devices.

Fifth Generation:
Fifth generation computing devices, based on artificial intelligence, are still in development, though
there are some applications, such as voice recognition, that are being used today. The speed is
extremely high in fifth generation computer. The use of parallel processing and superconductors is
helping to make artificial intelligence a reality. Quantum computation, molecular and
nanotechnology will radically change the face of computers in years to come. The goal of fifth
generation computing is to develop devices that respond to natural language input, capability of
learning by themselves and also being self-organized.
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First Generation:

[J Vacuum tubes for internal operations
[J Primary Memory Limited
[J Heat and Maintenance problem
[J Punched cards for input and output

Second Generation:

[J Transistors for internal operations
[J Smaller than vacuum-tube-built computers
[J Thousand times faster than first-generation computers
[J Magnetic tapes and disks for secondary storage
[J Increased processing speed and reliability
[J Increased use of high-level languages

Third Generation:

[J Hundreds of transistors packed into a single integrated circuit on a silicon chip for
internal operations

[J Dramatic reduction in size and cost
[J Significant increase in reliability, speed, and efficiency
[J Increased primary memory capacity

Fourth Generation:

[J Large scale and VLSI for internal operations
[J Development of the microprocessor
[J Greater versatility in software's
[J Introduction of microcomputers and super computers

1.S. Types of Computers:

Computers can be classified into two categories: Analog and Digital computers

Analog Computer Digital Computer
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Analog computers operate by measuring rather than counting. These computers use signals as
input, which can come from devices like speedometers, thermometers etc. These signals are
continuous flow of physical quantities like speed, temperature, pressure etc. Analog computer has
only limited memory facility and is restricted in the type of calculations it can perform.

Digital computers represents data in the form digits and all operations are done on these digits at
extremely fast rates. Digital computers basically know how to count the digits. These computers are
mostly used in engineering and scientific calculations. Digital watches are good example of a digital
computer.

Hybrid computer is a combination of both analog and digital computers. i.e., a part of processing is
done on analog and a part on digital computer. It provides greater precision than can be attained
with analog computers, greater control and speed than is possible with digital computers. It can
accept input data in both analog and digital form. It is used for simulation applications.

Digital Computers are divided into the following categories:

• Mini Computers
• Mainframe computers
• Micro Computers
• Super Computers
•

Now let us discuss the varieties of digital computers that we see today. They can be divided into
different categories depending upon the size, efficiency, memory and number of users.

Microcomputer:
Microcomputer is at the lowest end of the computer range in terms of speed and storage capacity.
These are most widely used computers which we commonly refer to as "Personal Computers" or
"Desktop Computer". Its CPU is a microprocessor. The PC supports a number of input and output
devices. It can be used by only one user at a time. Examples of microcomputer are IBM PC, PC­
AT.

Mini Computer:
Mini computer is designed to support more than one user at a time. It possesses large storage
capacity and operates at a higher speed. The mini computer is used in a multi-user environment in
which various users can work at the same time. This type of computer is generally used for
processing large volume of data in an organization. They are also used as servers in Local Area
Networks (LAN).

Mainframes:
Mainframe computer is a computer, which has capability to support many terminals and
peripherals. These computers operate at very high speed, have very large storage capacity and
can handle the workload of many users. They are generally used in management of centralized
databases. They are also used as controlling nodes in Wide Area Networks (WAN). Examples of
mainframes are ICl, IBM 3000 series and DEC.

,
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Super computer:
Super computers are the fastest and most expensive machines. They have high Processing speed
compared to other computers. They also have multiprocessing techniques. These computers are
used widely in complex scientific applications like weather forecasting, genetic engineering,
biomedical research, remote sensing, aircraft design etc. One of the ways in which super
computers are built is by interconnecting hundreds of microprocessors. Examples of
supercomputers are CRAY YMP, CRAY2, CRAY XMP, PARAM from India and IBM's Bluegean.

1.9.Advantages of Computers:

• High rate of processing speed with reliability.
• Huge volumes of data can be stored in the memory and any particular data item can be

retrieved at random in a fraction of a second.
• Solution of a much-complicated problem is feasible at a greater speed.
• Processing of voluminous data saves a good lot of clerical labor, which in turn reduces the

processing cost.
• Performs operations efficiently even in environments inaccessible to humans, such as

furnace, poisonous atmosphere, vacuum, unmanned satellite etc.

1.10.Applications of Computers:
Computers were initially used for prime applications in the field of mathematics and science.
Their first effective utilization was made in the field of military for decoding the messages of the
enemy. Then they entered the application of real time control systems like landing on moon.
Currently maximum number of computers are being used in business and commercial sectors.
The following are the list of applications:

• Scientific applications
• Weather forecasting
• Online reservations
• Business and office
• Banking sector
• Electronics funds transfer (EFT)
• Electronic commerce
• Process control
• Computer aided design (CAD)
• Computer aided manufacturing (CAM)
• Electronic mail (e-mail)
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1.11.Summary:
In this lesson we discussed the major characteristics of a computer. The speed, accuracy, memory
and versatility are some of the features associated with a computer. Computer performs operations
automatically. Computer system involves two major components hardware and software. Hardware
refers to physical components of a system and software refers to a set of programs. The computer
that we see today was not developed over night. It has taken centuries of human effort to see the
computer in its present form today. Computers history began with the development of a counting
device called ABACUS, later several evaluations including analog machines, mechanical
calculators, electrical machine and other modern computers. Computers are classified into several
generations based on the technology used in building the computer. There are five generations of
computers. Over these generations the physical size of computer has decreased, and on the other
hand the processing speed of computer has improved tremendously. The Computers have proved
not only their presence but also their effectiveness in whatever field they foray.

1.12.Technical Terms:

Chip: A tiny wafer of silicon containing miniature electric circuits that can store million of bits of
information.

VLSI (Very Large Scale Integration): The use of integrated circuits with 100,000 to a million logic
gates.

Artificial intelligence (AI): The study of thinking process of humans and representation of those
processes via machines (computer, robots, etc.)

Microprocessor :A complete central processing unit (CPU) contained on a single silicon chip.

Laptop: Small, lightweight, portable battery-powered computers that can fit onto our lap. They have
a thin, flat, liquid crystal display screen.

E-mail (Electronic mail): A service that sends messages on computers via local or global
networks.

1.13.Model Questions:

1. What is a computer and explain the characteristics of a computer?
2. What are the major limitations of a computer?
3. What is Software and Hardware?
4. Briefly explain History of computers?
5. Explain Generations of computers?
6. Write about different types of computers?
7. Write short notes on advantages and applications of computers?

,
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Lesson: 2

Components of a computer

2.0 Objectives:

The main objectives of this lesson are:

• To understand the four basic operations of the computer.
• To know the basic components of the computer and their functions.
• To know the function of memory and different kinds of memory.
• To understand the concept of cache memory and registers.
• To know about input and output devices.

Structure of the lesson:

2.1. Introduction

2.2. Operations of a computer system

2.3. Block diagram of a computer

2.4. Types of memory

2.4.1. Primary memory

2.4.2. Secondary memory

2.5. Cache memory

2.6. Registers

2.7. Input devices

2.8. Output devices

2.9. Summary

2.10.Technical terms

2.11.Model Questions

2.12.References

2.1. Introduction
In the previous lesson we discussed about the history and evolution of computer. In this

lesson we will have an overview of the basic design of a computer. We will know how different parts
of a computer are organized and how various operations are performed between different parts to
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do a specific task. The internal architecture of computer may differ from system to system, but the
basic organization remains the same for all computer systems.

2.2. Operations of a Computer System:

Computer system has four main stages: The Input stage- where data is put into the computer.
The Processing stage - where the data is processed. Storage and The Output stage - where the
results are displayed.

Input:
Input is supplied to the computer with the use of a keyboard, a mouse, or another input device.
These input devices may be called peripheral devices.

Processing:
Processing is done inside the computer in an area called the central processing unit (CPU).
Processing is the conversion of input to output.

Storage:
Storage refers to holding information in a specific place.

Output:
Output is the result of a computer process. Output may be viewed on a monitor screen, heard
through speakers, printed on paper with printers, and so forth.

2.3. Block diagram of a computer:

Basic functional units of a digital computer includes three major parts:
o Input unit
o Central processing unit (CPU)
o Output unit

Input Unit:
Computer processes data to produce some form of useful information as output. To do this,

a computer needs some kind of data (facts, numbers, characters etc) to be processed called Input.
So we need a device to enter data into the computer. Input unit writes the instructions and data into
a computer's memory. Input unit of computer is similar to our 'ears' and 'eyes' through which we
receive data. Input devices deal with original data. Various input devices in use are:Keyboard,
Mouse, Scanner, light pen, Graphic Tablet, Touch panel, Optical Mark reader, Magnetic tapes,
Magnetic drums.
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Block Diagram of a Computer

D\.
Control
U_rit

CPU

1 r
Secondary storage

Output
Devices

~ation

Central Processing Unit (CPU):
The central processing unit (CPU) is an essential component of a computer. Because it is the part
that executes the programs and controls the operations of all the hardware. The central processing
unit (CPU) is like our brain.
It consists of three units: 1. Arithmetic and Logic unit (ALU)

2. Control unit (CU)
3. Memory unit (MU)

ALU (Arithmetic and Logic Unit):
Arithmetic and logic unit is the part of the CPU, where arithmetic and logical functions are
performed, i.e., mathematical or arithmetic functions like addition, subtraction, multiplication,
division etc. Logical operations like logical AND, OR, NOT.

Control Unit: The Control unit is the circuitry that controls the flow of information through the
processor and co-ordinates the activities of the other units within it. It also controls transfer of data
between CPU and memory and CPU and 1/0 devices.

Memory Unit: Memory stores the input from input device and output from the CPU, as well as the
instructions that are followed by the CPU. All the instructions, data, intermediate results of any
calculation and final output in the memory can be retrieved when necessary. The data and
commands are stored in the addresses called memory locations.
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The amount of storage in the memory can be measured. The units of measurement of memory are

bit=Oor1
nibble= 4 bits
1byte=8 bits
1 Kilo byte (KB)= 1024 bytes
1 Mega byte (MB)=1024 KB
1 Giga byte (GB) = 1024 MB

The are two types of memory, primary or main memory and secondary or auxiliary memory.

Output Unit: Output devices allow us to get information from the computer. Various output devices
are: Monitor, Printer, Speakers, CRT - Cathode Ray Tube, Plasma, LCD - Liquid Crystal Display.

2.4. Types of Memory:
Memory:
Memory is the storage area where the computer stores the instructions for solving a problem, the
data to be processed, the intermediate results and the final results until they are displayed.

Types of Memories: Memory can be divided into two main categories:
• Main Memory or Primary Memory
• Secondary Memory or Auxiliary memory
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Primary memory consists of data that are actively being used. It is typically high-speed, relatively
small, is often volatile. It is sometimes referred to as "Main Memory". It can be accessed
immediately and randomly. Primary memory is divided into RAM and ROM.

Secondary memory, also known as peripheral storage, is where the computer stores information
that is not currently in use. It is typically slower and has higher capacity than primary storage. It is
non-volatile.

2.4.1. Primary Memory:

Random Access Memory (RAM):
The primary storage is referred to as random access memory (RAM) because it is possible to
randomly select and use any location of the memory, directly store and retrieve data. It is also
called read/write memory. The storage of data and instructions inside the primary storage is
temporary. The contents of RAM are lost as soon as the power to the computer is switched off or if
there is a minor fluctuation in the power supply. The memories, which loose their content on failure
of power supply, are known as volatile memories. There are different types of RAM:

Static RAM (SRAM): This RAM will maintain its data as long as power is provided to the
memory chips. It does not need to be rewritten periodically. SRAM is often used as cache
memory due to its speed.

Dynamic RAM (DRAM):DRAM unlike SRAM, must be continuously re-written in order for it
to maintain its data. DRAM is used for most system memory because it is cheap and small.

Read Only Memory (ROM):
Storage of program and data in the ROM is permanent. The ROM stores some standard
processing programs supplied by the manufacturers to operate the personal computer. The
contents of ROM can only be read by the CPU, but it cannot alter the contents. The basic
input/output program is stored in the ROM. It examines and initializes various equipment attached
to the PC. The memories, which do not loose their content on failure of power supply, are known as
non-volatile memories. ROM is non-volatile memory.

PROM (PROGRAMMABLE READ ONLY MEMORy): We know that it is not possible to
modify or erase programs stored in ROM, but in PROM it is possible for us to store our
program in PROM chip. Writing of programs in PROM can only be done once.

EPROM(ERASABLE PROGRAMMABLE READ ONLY MEMORy}:This memory chip
overcomes the problem of PROM and ROM. EPROM chip can be programmed time to time
by erasing the information stored earlier in it. Information stored in EPROM is erased by
exposing it to ultraviolet light. It can be reprogrammed using a special programming facility.

EEPROM: Stands for Electrically Erasable Programmable Read Only Memory. This ROM
can be written through the use of a special software program.
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2.4.2. Secondary Memory:

Secondary memories are also known as Auxiliary memory. It is the memory supplement to
main storage. This is a non-volatile memory. The term non-volatile means it stores and retains the
programs and data even after the computer is switched off. The operating speed is slower than that
of the primary storage. Huge volumes of data are stored here on permanent basis and transferred
to the primary storage as and when required.

The most common types of auxiliary storage devices are magnetic tape, magnetic disk,
floppy ~isk, hard disk, and optical disk. These devices are divided into two categories based on the
type of the access: Sequential and Random. Magnetic tapes are examples of sequential
accessing devices in which the data can be accessed one after another in a sequential order. In
contrast, disks are random-access devices in which the data accessing is direct. Other examples of
direct access devices are magnetic disks, optical disks, zip disks etc.

Magnetic Tape:
Magneti,c tapes are used for large computers like mainframe computers where large volumes of
data is stored for a longer time. In PC we can also use tapes in the form of cassettes. The cost of
storing data in tapes is inexpensive. Tapes consist of magnetized material that store data
permanently. It similar to cassette tape used in a tape recorder. Accessing data on tapes is much
slower than accessing data on disks. Tapes come in variety of sizes and formats.

Magnetic Disk:
Hard disk is a magnetic disk on which we can store computer data. Hard disks hold more data and
are faster than floppy disks. A single hard disk usually consists of several platters. Each platter
requires two read/write heads, one for each side. It rotates at very high speed. Data is stored on
both the surfaces of the disk. Magnetic disks are most popular for direct access storage device.
Each disk consists of a number of invisible concentric circles called tracks. Information is recorded
on track~ of a disk surface in the form of tiny magnetic spots. The presence of a magnetic spot
represer1tsone bit and its absence represents zero bit.

Floppy Disk:
It is similar to magnetic disk. Floppy disks are portable, because we can remove them from a disk
drive. Disk drives for floppy disks are floppy drives. Floppies come in two sizes: They are 5.25 inch
or 3.5 inch in diameter. The capacity of a 5.25-inch floppy is 1.2 mega bytes(1.2MB) whereas for
3.5 inch floppy it is 1.44 mega bytes(1.44MB). It is cheaper than any other storage devices. Floppy
is a low cost device particularly suitable for personal computer system.

Optical Disk:
Optical disks are a storage medium from which data is read and to which it is written by lasers.
Optical disks can store much more data - upto 6GB. There are three basic types of optical disks.
They are:

o Compact Disk! Read Only Memory (CD-ROM)
o Write Once, Read Many (WORM)
o Erasable Optical Disk
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2.5. Cache Memory:

The speed of CPU is extremely high compared to the access time of main memory. Therefore the
performance of CPU decreases due to the slow speed of main memory. To compensate the
mismatch in operating speed, a small memory chip is attached between CPU and main memory
whose access time is very close to the processing speed of CPU. It is called cache memory.
Cache memories are accessed much faster than conventional RAM. It is used to store programs or
data currently being executed or temporary data frequently used by the CPU. So each memory
makes main memory to be faster and larger than it really is. It is very expensive to have bigger size
of cache memory, its size is normally kept small.

2.6.Registers:

The CPU processes data and instructions with high speed. There is also movement of data
between various units of computer. It is necessary to transfer the processed data with high speed.
So the computer uses a number of special memory units called registers. They are not part of the
main memory but they store data or information temporarily and pass it on as directed by the
control unit.

2.7 Input Devices:

Input devices are necessary to convert our information or data into a form, which can be
understood by the computer. A good input device should provide timely, accurate and useful data
to the main memory of the computer for processing. Following are the most useful input devices.

Keyboard:
The most often used input device is the keyboard. This is the standard input device attached to all
computers. The layout of keyboard is just like the traditional typewriter. It also contains some extra
command keys and function keys. It contains a total of 101 to 104 keys.

Mouse:
Mouse is an input device that can be connected to our personal computer. It rolls on a small ball
and has two or three buttons on the top. When you roll the mouse on a flat surface, you control the
position of the computer's cursor, or pointer, on the screen. As you slide the mouse forward, for
instance, the cursor moves forward to the top of the screen. With many programs, the computer
conveys your commands to the computer via on-screen pictures or icons. The cursor moves very
fast with mouse giving you more freedom to work in any direction.

Scanner:
The keyboard can input only text through keys provided in it. If we want to input a picture the
keyboard cannot do that. Scanner is an optical device that can input any graphical matter and
display it back. The common optical scanner devices are Magnetic Ink Character Recognition
(MICR), Optical Mark Reader (OMR) and Optical Character Reader (OCR).
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Magnetic Ink Character Recognition (MICR): This is widely used by banks to process
large volumes of cheques and drafts. Cheques are put inside the MICR. As they enter the
reading unit the cheques pass through the magnetic field, which causes the read head to
recognize the characters on the cheque.

Optical Mark Reader (OMR): This technique is used for evaluation of objective type
answers. The answering will be done by darkening a square or circular space by pencil. The
OMR is used to read the answers on the sheet and computer compares them with the
answers in the memory for evaluation.
Optical Character Recognition (OCR):
This technique unites the direct reading and comparing of any printed character. Suppose
we have a set of hand written characters on a piece of paper, the OCR is used to read and
compare these with a set of patterns stored inside the computer.

2.8 Output Devices:

Visual Display Unit (YOU):
The most popular input/output device is the Visual Display Unit (VDU). It is also called the monitor.
Monitor is used to display the input data and to receive messages from the computer. The contents
of the memory can be viewed on a monitor. A monitor has its own box, which is separated from the
main computer system and is connected to the computer by a cable. In some systems it is compact
with the system unit. It can be color or monochrome.

Terminlls:
It is a very popular interactive input-output unit. It can be divided into two types: hard copy terminals
and soft copy terminals. A hard copy terminal provides a printout on paper whereas soft copy
terminals provide visual copy on monitor. A terminal when connected to a CPU sends instructions
directly to the computer. Terminals can be classified as dumb terminals or intelligent terminals
depending upon the work situation.

Printer:
It is an important output device, which can be used to get a printed copy of the processed text or
result on paper. There are different types of printers that are designed for different types of
applications. Depending on their speed and approach of printing. Printers are classified as impact
and non-impact printers. Impact printers use the familiar typewriter approach of hammering a
typeface against the paper and inked ribbon. Dot-matrix printers are of this type. Non-impact
printers do not hit or impact a ribbon to print. They use electro-static chemicals and ink-jet
technologies. Laser printers and Ink-jet printers are of this type. This type of printers can produce
color printing and graphics.

2.9.Summary:

In general, a computer is a machine, which accepts data processes it and returns processed
information as output. As you become familiar with software and hardware we will have a better
understanding of technology for business and for our home. Technology is a vast field and learning
it will be a life long process.
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In this lesson we discussed five basic operations that a computer performs. That is input, storage,
processing, output and control. A computer accepts data as input, stores it, processes it as the user
requires and provides the output in a desired format. The storage unit of a computer is divided into
two parts: primary storage and secondary storage. All computers have several parts in common:

• Input devices allow data and instructions or commands to be entered into the system.
• A means of storing instructions and data.

• A central processing unit (CPU) which controls the processing.

• A means of returning the processed information in the form of output.

2.10. Technical Terms:

Bit: stands for binary digit. The smallest piece of computer information, either the digit 0 or 1.
Binary code: The most basic language a computer understands, it is composed of a series of Os
and 1s.

Memory: storage for information, including applications and documents.

Program: A series of instructions written in a computer language that tells the computer what to do
and how to do it.

1/0: Transfer of data into a computer, and from the computer to the outside world.

Flash memory: A small printed circuit board that holds large amounts of data in memory.

Laser :(Iight amplification through stimulated emissions of radiation)

A device that uses the oscillation of atoms or molecules between energy levels to generate a
narrow, finely focused beam of light. Lasers are used in fiber optics, laser printers, CD-ROM
players, and scanners.

2.11. Model Questions:
1. What are the basic operations performed by any computer system?

2. Draw a block diagram of a computer? Explain the function of various units.

3. Differentiate between RAM and ROM. Also distinguish between PROM and EPROM?

4. Write about cache memory and registers?

5. Write short notes on

(a) ALU

(b) Random Access Memory (RAM)
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6. Explain the significance of input, output devices in a computer. List various input, output
devices that you know?

2.12. References:
Prof.G.S.Prasad, M.Sc, M.S "Fundamentals of Computer - Telugu Academy"
Dharma Raja Raman "Computer Primer"
Alexis Leon & Mathews Leon "Fundamentals of Information Technology"
A.Jaiswal "Fundamentals of computers and Information technology"
N.Subramainian "Computer Genesis, Programming & applications"

G. RAMANJAIAH.,M.Sc (Computers)
Lecturer, Dept.Of Computer Science,
JKC College, GUNTUR.
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Lesson 3:

Computer languages and Operating
system concepts

3.0Objectives:

The main objectives of this lesson are:

• To know the concept of software.
• To understand different types of software.
• To know what a language is.
• To know about different types of translators.
• To know what an Operating System is.
• To know about Booting process
• To understand various types of operating systems.
• To know the basic concepts in DOS
• To understand Internal and External commands.

Structure of the Lesson:

3.1. Introduction
3.2. What is software?
3.3. Computer languages
3.4. Translators
3.5. What is an operating system
3.6. Types of operating systems
3.7. Introduction to DOS
3.S. DOS internal commands
3.9. DOS external commands
3.10. Summary
3.11. Technical terms
3.12. Model questions
3.13. References
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3.1. Introduction:
In the previous lesson we discussed about the parts and functions of computer. It has been
mentioned that programs or commands have to be fed to the computer to do a specific task. So it
is necessary to provide sequence of instructions for our work to be done. We can divide the
complier components into two major areas, namely, hardware and software. Hardware is the
physical components of a computer system. Software is the set of programs.

3.2.What is Software?
As we know computers will not function without instructions from the user, for a specific job to be
accomplished we have to give a sequence of instructions to the computer. This set of instructions
or commands is called a computer program. Software refers to a set or group of computer
programs, procedures that describe the programs and how they are to be used. The process of
software development is called programming.

Both software and hardware have to work together to produce meaningful result. To develop a
software is difficult and expensive.

Computer software is normally classified into two broad categories.
• System software
• Application software

System Software: System software may be defined as a set of one or more programs designed to
control the operation of the computer system. System software also facilitates the programming,
testing, and debugging of computer programs.

Application Software: Application Software is a set of programs to carry out operations for a
specific application. For example, railway reservation system software, hotel management
software, payroll software, etc., Application software is useful for word processing, billing system,
accounting, producing statistical report, analysis of numerous data in research, weather
forecasting, etc.

3.3.Computer Languages

Language is a system of communication between two people. Some of the basic natural languages
that we are familiar with are English, Hindi, Telugu etc,. These languages are used to communicate
among various categories of people.

Computer will not understand any of the natural languages. So we need a language to
communicate with computer. There are programming languages specially developed so that we
could pass our data and instructions to the computer to do specific job. Some of these languages
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are PASCAL,FORTRAN, BASIC, COBOL, C, C++, VC++ etc. So instructions or programs are
written in a particular language based on the type of job.

Programming Languages:

There are two major types of programming languages. These are Low Level Languages and High
Level Languages. Low Level languages are further divided in to Machine language and Assembly
language.

Low Level Languages

The term low level means closeness to the way in which the machine can understand.

Machine Language

Machine Language is the only language that can be directly understood by the computer. It does
not need any translator program. We also call it machine code and it is written as strings of 1's
(one) and O's (zero). When this sequence of codes is fed to the computer, it recognizes the codes
and converts it into electrical signals. For example, a program instruction may look like this:

1011000111101

It is not an easy to learn and write instructions in this form. Because of the complexity very few
people can write the programs in this language. It is considered to be the first generation language.

The only advantage is that program written in machine language run very fast because no
translation is required for the CPU.

Assembly Language:

A low-level programming language that is Slightly more user-friendly than machine language. The
software which translates a program written in assembly language to machine language is called
an assembler. These are considered to be second-generation languages.

Advantages of assembly language are:
It is easier to understand and write programs which are nearer to English language. It saves a lot
of time for the programmer, easier to correct errors and modify the program instructions whenever
necessary.

High·level Language:

These are third-generation or 3GLs. These are closer to so-called naturallanguages(we talk).High­
level languages are simple languages that use English and mathematical symbols like +, -, %, I etc.
for its program construction. Any program written in High-level language has to be converted to
machine language for the computer to understand.
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Higher-level languages are problem-oriented languages because the instructions are suitable for
solving a particular problem. Choice of a particular high-level language depends on the
application/problem. Advantages of High Level Languages are easy to learn and use because that
they are similar to the languages used by us in our day-to-day life.

3.4.Translators
Translator:

Translator is a program, which converts source language to object language.

Assembler:
Assembler is a translator or converter, which converts assembly language program (Mnemonics or
symbols) to machine understandable code called machine language (Osand 1s).

Assembler needs two passes to convert assembly language program to machine language
program.

Assembly Machine• •
language I Assembler I Language

Compiler:

The programs written by the programmer in high-level language is called source program. After this
program is converted to machine language by the compiler it is called object program.
Compiler translates the instruction of a higher-level language to machine language. Thus compiler
is a program translator like assembler but more sophisticated. It scans the entire program first and
then translates it into machine code.

Every high-level language has its own compiler. For example FORTRAN compiler will not compile
source code written in COBOL language.

High Level Machine•• I

language "I Compiler I Language

Interpreter:

An interpreter is another type of program translator used for translating higher-level language into
machine language. It takes one statement of high-level language, translates it into machine
language and immediately executes it. Translation and execution are carried out for each
statement.
It differs from compiler in the following aspects:
Compiler translates the entire source program into machine understandable form at a time and
generates an object code which can be used on repeated execution of the program.
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With interpreter the program needs to be retranslated every time you want the program to be
executed.

3.S.What is an operating system?

Operating system is software, which is an interface between the user of the computer and
computer hardware.
The following are the various operating systems: MS-DOS, Windows 95/98/2000/me/NTIXP, UNIX,
LlNUX etc.

3.6.Types of operating systems:

Basically there are two types of operating systems, single user operating system and multi user
operating system.

Single user operating system:
Single user operating system allows one program to execute at a time. The program must
completely finish executing before the next can begin.

Multi user operating systems:
A multi user operating system allows a single CPU to execute what appears to be more than one
program at the same time, when, in fact only one program is being executed. The CPU switches its
attention between programs as it receives requests for processing, executing statements from one
program, and then from another. This processing happens so fast that it appears that the number
of users exceeds the operating system's capability; noticeable delays in processing will result.
Several other operating systems are:

Parallel System:
Some large computers may have more than one processor. In parallel processing systems, tasks
are shared between a numbers of processors. The operating system allocates instructions to each
processor. The more processors that are allocated to a task - the faster that task will be completed.

Distributed systems:
In a distributed system, computers and peripherals are linked together. Each user is not aware of
which computer or peripheral he is using. A user on one computer may be running a program
stored on another computer accessing data stored on yet another computer. Here the operating
system will control access to the resources.

Real Time systems:
Real-time means that data is processed immediately. The computer used in a real-time system is
'dedicated' - it does nothing else. An example of a real-time system is a Process-Control System.
Input data received from sensors is processed immediately, analyzed and any necessary actions
taken without any delay.
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3.7.introduction to Disk Operating System [ DOS]:

When the computer starts, the operating system takes control of the machine. An Operating
System is a group of programs that controls and manages the computer Hardware and the
Software resources of a computer system.

ABOUT MS-DOS

Microsoft DOS (Disk Operating System) is a command line user interface. MS-DOS 1.0 was
released in 1981 for IBM computers and the latest version of MS-DOS is MS-DOS 6.22, which was
released in 1994.
DOS operating System is used for operating the system or the computer. The main functions of
DOS are to manage disk files, allocate system resources according to the requirement. DOS
provides features required to control hardware devices such as Keyboard, Screen, Disk Devices,
Printers, and other programs.
Basically, DOS is the interface or a medium through which the user and external devices are
communicated. DOS converts the user commands into a computer understandable format. It also
translates the result and any error message in user understandable form.

Commands in DOS:
These are the instructions, which are used to communicate with the computer system. We call
these instructions are commands. The commands of the DOS are divided into two categories:
Internal Command and External Commands

Internal Command:
These are the commands, which reside in a portion of the computer's memory and are loaded
along with the operating system into the memory. These commands are always available for
execution. An Internal command, which is a command embedded into the command.com file.

External Command:
These are the commands, which have to be loaded from the disk into the memory of the computer
before we want to execute them. These commands are usually in the form of file, which resides in
the disk, as and when required they will be loaded into memory before execution.

3.8. DOS Internal Commands:

CLS:
CLS command allows a user to clear the complete contents of the screen and leave only a prompt.
Syntax: CLS

VOL:
VOL command displays the volume information about the designated drive.
Syntax: VOL
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VER:
VER command displays the version of MS-DOS or if running Windows 95 or above the version of
Windows.

Syntax: VER

TIME:
Allows the user to view and edit the computer system time.

Syntax: TIME [time] Displays or sets the system time.
Type TIME with no parameters. Displays the current time setting and a prompt for a new one.
Press ENTER to keep the same time.

DATE:
The date command can be used to view the current date of the computer as well as change the
date.

Syntax: Displays or sets the date.
DATE [date]

Type DATE without parameters. Displays the current date setting and
Press ENTER to keep the same date

a prompt for a new one.

DEL:
DEL is a command used to delete files from the memory of the computer.

Syntax:

Ex:

Deletes one or more files.
DEL [drive:][path]filename [/P]
del ramu.txt

REN:
Used to rename files and directories from the original name to a new
name.

Syntax:
Ex:

REN old name new name
REM RAMU.TXT HANUMAN.TXT

CD:
CD (Change Directory) is a command used to switch directories in MS-DOS. The Change Directory
(CHOIR) or CD command enables the user to travel around the directories in a disk. Type the CD
command at the command prompt.

Syntax:
CD[..]
Ex:

CD[drive:][path]
cd.. - Goes back one directory.

CD MAIN
CD..
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DIR:
The dir command allows us to see the available files in the current and or parent directories.
Syntax: Displays a list of files and subdirectories in a directory.

DIR [drive:][path][filename] [/P] [/W] [/A[[:]attributes]]

Ip - pauses after each screen full of information.
Iw - uses wide list information.
10 - list of files in sorted order.
II - uses lowercase letter.

Ex: dir/p

COPY:
Allows the user to copy one or more files to an alternate location.
Syntax:: Copies one or more files to another location.

COPY [/A lIB] source [/A lIB] [+ source [/A lIB] [+ ...]] [destination] [/A lIB]]
[N][/Y I 1-Y]

Ex:
User can create a file using the copy command. In the below example we create the file called
"test.txt" .
copy con test.txt
Once the above command has been typed in a user could type in whatever contents he or
she wish.s. When you have completed creating the file you can save and exit the file by
pressing 'and holding CTRL key and pressing Z key and then press enter. A simple
alternative would be pressing F6 functional key.

RD:
Removes empty directories in MS-DOS.
Syntax: Removes (deletes) a directory.

RMDIR [drive:]path
RD [drive:]path

Ex: ROMAIN

3.9.DOS External Commands:

CHKDSK:
chkdsk is a utility, which checks the computers hard disk drives status for any cross-linked or any
additional errors with the hard disk drive. It checks for the memory and gives the detailed
information about the memory consumed as well as free memory.

DISKCOPY:
The disk copy utility allows a user to copy the complete contents of a diskette to another diskette
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Object Program: the machine language program resulting from the translation of a user(source)
program,
Source program: A program written following the syntax of a language.
Time-shared system: A computer system with an operating system designed to allow many users
to simultaneously use it.

3.12. Model Questions:

!. ~~at ~ssoftware and hardware? Differentiate application and system software?
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DOSKEY:
Doskey is a MS-DOS utility that allows a user to keep a history of commands used on the
computer. This allows frequently used commands to be used without having to type the commands
in each time you need to use it.

EDIT:
Edit allows a user to view, create and or modify their computer files.

FDISK:
Fdisk allows the user to delete and/or create partitions on the hard disk drive.

FORMAT:
Format is used to erase all of the information off of a computer diskette or fixed drive.

LABEL:
Label is used to view or change the label of the computer disk drives.

TREE:
This command is used to display all the directories and also the files if specified.

3.10.Summary:

In this lesson we discussed about two types of software, namely, system software and application
software. It is designed for performing tasks such as controlling all operations required to move
data into and out of the computer. It communicates with printer, card reader, disk, tapes, etc. and
monitors the use of various components like memory, CPU, etc. Application software is a set of
programs written for specific purpose. We have discussed about levels of computer language.

In this lesson we discussed very important software component called operating system.
Operating system is system software, which provides a link between the user of a computer and
hardware. It controls all the activities of the computer system. There are different types of operating
systems: single user, multi user, parallel, distributed and real time operating systems. In this lesson
we discussed introduction to DOS, internal and external commands.

3.11.Technical terms:

CPU: Central processing unit of a computer. Its consists of three sub-units: ALU - Arithmetic and
Logical Unit

CU - Control Unit
MU - Memory Unit (Main memory)

FORTRAN: FORmula TRANslation, a high level language used for scientific and engineering
applications.
MS-DOS: an operating system designed by Microsoft corporation for IBM compatible personal
computers.

4.1

Lesson 4

Windows Operating system concepts
4.0 Objectives:
At the end of the lesson the student must be able to understand
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Windows 98 is an operating system (OS). An operating system is the software that runs on your
computer to control the basic operation of your computer's hardware components such as the
processor, monitor, keyboard, mouse, memory, drives, printers, scanners, etc. Applications such
as Microsoft Word and Excel must run "on top" of the operating system.

Microsoft windows is the popular GUI based operating system from Microsoft Corporation, offers an
excellent platform and environment for the user. This is very user-friendly environment. Windows
has several versions windows 3.xI 95/98/me/2000/NT/XP. Windows 95 and 98 are single user
operating systems and where as Windows NT / servers are multi user operating system.

4.2.Features of Windows:
• Windows provides user-friendly environment.
• It is an easy-to-use, consistent Graphical User Interface environment.
• It is capable of multitasking of graphical programs and character based programs.
• Program manager can be used to switch easily between multiple programs.
• Built in accessories such as wordpad and paint.
• A powerful help facility is provided which will enable a user to sort out its problems

in comfortable manner.
• For entertainment, window comes with some games.
• Searching for specific files is very easy.
• It provides multimedia related applications.

4.3.0verview of Windows Desktop:
When the computer is switched on, windows starts automatically. It displays a login screen where
the user name and password for using the network services has to be entered. On entering the
correct password, the user will be able to use network services. If the user clicks on Cancel button,
user will not able to use the network services. Then it shows the Desktop.

R.."....Bin

Start button Taskbar
./'-

Clock

)
The Windows Desktop
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Desktop:

The entire screen is called the desktop. It is the first view after entering the password in the login
screen. The pictures on the desktop are known as icons. These icons can be arranged in any order
in the desktop.

Taskbar:

The rectangular bar that runs horizontally across the bottom of the screen is called taskbar. The
position of the taskbar can shift according to the user's requirement. It provides access to the all
programs. It includes start button, current time etc.

4.4.1cons on the Desktop
Icons are small graphical images that can represent computer programs, files, folders and printers
among other things. To activate an icon you double click on it with the left mouse button, this will
activate the icon and either start a program or open a file/folder.

The icons on your desktop can be renamed by right clicking on them and selecting rename,
Similarly they can be deleted by right clicking and selecting delete.

My Computer:
This is a standard icon and is very useful; it contains all the resources available in the computer.
Generally it consists of all the drives in the computer, control panel, printer folder. To change the
view of the contents in my computer, we use the various options in the view menu.

My Documents:
The My Documents icon links to a standard folder, which Windows 98 uses to store the documents.
By default Windows 98 will save any documents we create in this folder.

Internet Explorer:
This icon is a shortcut to Microsoft's Internet Explorer program. Internet Explorer is used to view
web sites and web pages on the Internet.

Network Neighborhood:
The Network Neighborhood Icon represents a folder that contains links to any other computers that
are in workgroup. The contents of network neighborhood are workgroups, servers, share folder
and printers.

Recycle Bin:
All files and folders, which are deleted from the windows, are stored in the recycle bin. By default
windows 98 is setup to deposit all deleted files, folders or icons in the recycle bin. Recycle bin can
be used to restore files that have been deleted.
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4.S.Parts of a Window:

Every program window looks a little different because each has its own menus, icons, and controls.

Windows has Title bar, Control menu, Minimize box, Maximize/restore box, Close button,
Status bat, Menu bar.

m....

Menu Maximize
Title bar Minimi

Close

Address bar

status bar
Title bar~
The title bar is the horizontal bar at the top of a window that shows the name of the program
and document. You can move window around your desktop. The title bar is highlighted
when the window is active.

Control menu:
This has list of commands, usually contains minimize, maximize, move, size etc.

Minimize button:
Click the Minimize button to reduce the active window to a button on the taskbar using minimum
space on the screen.
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Maximize Button:
Click the Maximize button to expand the active window to fit the full screen. Click the maximize
button again to restore the window to the smaller size.

Resizing Button:
Only the window, which is maximized, can be resized.

Close Button: Click the Close button to close the active window or program.

Menu Button: Consists of a set of keywords (control words) for this window.

Status Bar: Shows the comment on selected item.

Menu bar:Window menu is a list of commands that you can select. Click a menu bar item to
perform a command in a program.

4.6.Mouse operations:

The mouse is used to move around and activate different features of
Windows applications in the following manner
Click:
Press and release the left button on the mouse.
Right Click:
Point the mouse and then clicking the right button to display the short-cut
menu for that item.
Double click:
Point the mouse to an item of choice and click the left button twice, rapidly.
This is used to start programs and open files.
Drag & Drop:
Hold down the left mouse button of the mouse while you are moving the mouse and release
it at the desired position.

4.7.File Commands:

Copying:
Copying files to another directory or drive. Select explorer: Select the files to be copied, hold the ctrl
key, and Drag the selection to the destination.

Deleting:
Deletes selected files. Select the files and press Del or File Delete, Delete dialog box appears
showing the current directory and the name of the file to be deleted. Click on Yes button. The
deleted files are sent to recycle bin.

Renaming:
Renames selected files. Select the item to be renamed, Choose File -> Rename, Current name get
selected, and Type the new name. Press enter or click outside the file name.
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Moving:
Move the files to another directory. Select the files to be moved and then drag them as a group to
the new destination.

4.8.FileAttributes:

Select the files whose attributes you want to alter. Choose File -> Properties then Properties Dialog
box appears, check the boxes appropriately. The attributes are:

Read only: Does not allow anyone to make any changes to the file.

Archive: Indicates the file has been modified since the last backup. This is used by backup
program such as the DOS backup command.

Hidden: Hides the file from the directory listing in DOS and directory
Windows in the explorer.

System: To tell windows that it is an Operating system file. Move the mouse pointer to the menu
item in the menu bar and then click on it.

Closing menu: Click on the Menu or anywhere outside the menu. Choosing a menu item, Click on
the items using mouse.

4.9.Speciallndicators in Menu:

Window menu often have special symbols that tell you more about Menu Commands. They
are

Dimmed command name: If a menu command is dull or gray in color it means that this choice is
not currently available.

Ellipses( ... ) : If the window or window application requires more information from your end before
the execution of a particular command, the names of such commands shall be followed by Ellipses.

Triangle( ~): A triangle preceding the command has additional sub-choices for you to be made.
Selecting such command brings up a cascading menu with more options to chosen from.

Option buttons( • ): There are exclusive settings. They are round boxes, and only one can be set
on at a time. To select an option button click on the option button.

4.10.The Start Button:
The Start button is the single most commonly used feature in windows. . This button is the

primary thing of starting programs from the desktop. This is a very important part of Windows.
Using the Start button you can start programs, open documents, customize your system, get help,
search for items on your computer, and more.
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To open a start menu item, first click Start. The start menu opens showing you the first level of
menu items. When you move the mouse pointer over any menu item that has an arrow next to it,
another menu, or submenu, opens and reveals related files, programs, or commands. Click on a file
or program to open it. The Start Button gives you access to programs that you have loaded on the
computer. It also lets you access common tools that come with Windows.

4.11.0verview of the Start menu:

Programs:
This section of the Start Menu holds all of the program groups and programs installed on your
machine. You can open the programs menu by pointing to it with the mouse.

Favorites:
This Folder keeps track of your favorite files: games, programs, web-sites, you name it. Click on
any item in the list to automatically go there.

Documents:
The Documents section contains the last few documents you worked on. By clicking on a document
name, the document will be opened in the program that was used to create it.

Settings:
The Settings section enables you to change the settings and basic appearance of Windows 98.

Find:
Use the Find feature to search a drive, multiple drives, or your entire system (including networked
drives) for a folder or file you are searching for.

Help
Help starts the Windows 98 help program. This program can also be accessed by pressing F1. See
the Help section for more information

Run
Run can be used to start a program on your hard drive or on a floppy disk. To start a program,
either type in the name of the program, or choose Browse to select the file to run

Log Off
Use this feature if you want to log off your system and allow someone else to log on without running
through a complete shut down of the system.

Shutdown
The Shutdown menu will allow you to turn the computer off or reboot your system as you choose.

a



Click the button. Put to setting on Start menu.
On the menu click on the Taskbar.
Select Taskbar options tab.
You can change the following settings, using the
options

•
• small icons in Start menu

clock•

Clock· Setting The Date and Time:

or time is incorrect, right click on the clock and select adjust date/time.

Select the correct year, month and day from the
calendar area on the left side of the window. On the
text box, which displays the digital clock, using the left
mouse button, single click to place the cursor in the
area which is incorrect, hh, mm, ss, am/pm.

Use the scroll areas to the right to increase or
decrease the time, which ever is applicable. When the
date and time is correct, press the OK button to exit.
Other clock properties can be found in the Regional
Settings option found in the Control Panel.
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4.14.The Shutdown menu:

We should never just tum off the computer. To avoid damage to the system or loss of files, always
follow specific steps to shut down the computer. The Start menu is where you begin the shutdown
process. It has several options they are:

Shuts down the PC, always use this option to
your PC.
Restart:
This will restart the computer.
In MS·DOS Mode:
This will cause the PC to restart in the MS­
environment.

4.1S.The Find menu:

turn off

Restart

DOS

Files or Folders
This is used to search for files or folders on your PC (see related pages
at top of this page for a guide).
Computer
This is used to find computers on your network.
On the Internet
This will search the Internet for your query.
People
This will search your PC and other sources for people.

4.16.The Settings Menu:

Control Panel - The control panel is used to configure Windows 98.
Printers - Used to add and configure printers.
Taskbar & Start Menu - Here you can customise your taskbar & start
menu.
Folder Options - Here you can change the look and feel of your
folders.
Active Desktop - Changes thedesktop settings.
Windows Update - starts the automated windows update.
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4.17.The Documents folder:

A
'IIIl;

------ _-
I: II J';J!

This acts like a folder, it will contain the recently viewed documents for fast
access as well as a link to the main My Documents folder.

4.18.The Programs Menu:

To open a program simply left click on it, as with the start
menu t'e options with the small black arrow to the right hand
side contains another sub menu. For example if you wanted to
open a program in the accessories folder, then you would
hover t~e mouse over accessories and then click on the
program you want from the sub menu that appears.
You can rename any program on the menu by right clicking on
it and selecting rename from the menu that appears.
Whenever you install software it will (normally) appear on the
prograrps menu, if you ever want to remove a program then
use the control panel to uninstall it, simply deleting it from the
programs menu will not uninstall the software.

4.19.What is Windows Explorer?

Windo\t'S Explorer is a file management
progralYlsimilar to File Manager in Windows
3.1. It ailows customers to move or copy files
from one folder or drive to another, and to
safely 4elete files by sending them to the
recycle bin. In addition, Windows Explorer
allows you to view Web pages directly in the
window.

Windows98 separates the window into two
panes. If you click on an object in the left
pane, the contents of the object displays in
the right pane. Click on Desktop and the
contents of the Desktop folder display on the

,
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right. Click on My Computer and your computer resources are displayed on the right. To see the
contents of a drive, click on the drive. To see the contents of a folder, click on the icon for the
folder in the left pane.

4.20.Screen Properties:

To change or access options for the "look" of the desktop, right click on the desktop area. This area
should be free of icons. From the quick menu, which appears, select "Properties".

Background:
The background options allows your desktop to have fancy patterns and wallpaper for your viewing
pleasure.

Screen Savers:
It provides some thing to do while the computer is idle. If the computer is idle for a set period of
time, the screen saver will automatically begin. To stop the screen saver, simply move the mouse,
or press any key on the keyboard.lt will offer some security features (Password) also.

Appearance:
The appearance option is used to set the system colors for items such as desktop background, title
bars, menus etc. Use caution when selecting colors to ensure visibility of text.

Settings:
The settings option is used to change the viewing area of the desktop, setting font size, and size of
the desktop area. These settings can control one monitor in Windows '95, and two monitors in
Windows '98. They should only be changed by experienced users.

4.21.Summary:
In this lesson we discussed different type of operating system including windows

3.x/95/98/NTIXP. Windows is a popular Graphical user interface (GUI) based operating system
from Microsoft Corporation, offers an excellent platform and environment for the user. It provides
user-friendly environment.

Windows desktop contains several components, icons, start button. Every action should be starting
from the start button. We have discussed the start button items, parts of a window, and screen
properties like changing desktop wallpaper, screen saver windows explorer and its components.

4.22.Technical Terms:

GUI: Systems software that allows users to have direct control of the visible objects such as icons
and actions that replace command syntax.

Multitasking: The operation of two or more programs running on a single processor (CPU) at the
same time.
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Icon: An icon is a small object used to remind the user of a particular operation, idea or a project.

Window Operating system: An operating system from Microsoft, in a variety of products, that
provides a GUI using icons to provide instant access to common task.

Taskbar: A bar on the graphic user interface that shows all open applications and active windows.
Clicking any task button on the taskbar brings the corresponding session to the foreground.

Shutdown: The term "shut down" can be used to mean, "turning off" something, but most
commonly used for computers.

4.23.Model Questions:

1. What is windows operating system? Explain its features?
2. Explain the parts of a window?
3. Write about windows explorer?
4. Give overview of start button?
5. Write about file commands and attributes in windows?

4.24.References:

Alexis Leon & Mathews Leon "Fundamentals of Information Technology".

A.Jaiswal "Fundamentals of computers and Information technology",

Ron Mansfield "Working in Microsoft Office". Tata McGraw Hill.

Sharon Crawford and Neil J.Salkind "ABC of Windows 98" , BPB
publications.

G.RAMANJAIAH.,M.Sc(Computers)
Lecturer, Dept.Of Computer Science,
JKC College, GUNTUR.
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Lesson 5

Microsoft Office and Word Processing

5.0 Objectives:
This lesson provides an introduction to the Microsoft Office. It covers Microsoft Office Products,
introduction to Word-Processing and features of Word-Processing.

Structure of the Lesson:

5.1. Introduction to Microsoft Office
5.2. Word-processing
5.2. Features of word-processing
5.3. Summary
5.4. Technical Terms
5.5. Model Questions
5.6. References

5.1. Introduction to MS-OFFICE:
Microsoft Office for windows is a suite of applications that are also available as independent

programs. Microsoft Office is a major facility in computer applications field. Microsoft Office comes
in two ways. One is called Standard and other one is called Professional. Both the versions have
the following primary applications.

1. Microsoft Word

2. Microsoft Excel

3. Microsoft PowerPoint

4. Microsoft Access

5. Microsoft Mail

6. Microsoft Graph

7. Microsoft Clip Art Gallery

8. Microsoft Word Art

,
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9. Microsoft Organization Chart

10. Microsoft Equation Editor

11. Microsoft Publisher

Microsoft Word

This is a full-featured word processor that can create letters, menus, reports, newsletters,
manuals and any kind of documents. You can use it for daily correspondence and desktop
publishing also. It is having more menus, keyboard shortcuts and toolbars. Toolbars containing
buttons that you can click to perform, common tasks like centering text, saving and printing
documents. After developing our own working style we can make custom toolbars. Word provides
macro capability to do repetitive tasks. It provides some model reports called templates, rather
than typing all the matters it gives skeleton reports. Wizards are more powerful than templates.
Word having spell checker that checks the document and more features like Auto formatting,
Printing envelops and labels, Mail Merge.

Microsoft Excel

This is a spreadsheet program that allows you to organize, analyze information. It is
designed to work with numbers. You can enter data in cells arranged horizontal rows and vertical
columns on work sheets. Excel organizes the worksheets with workbook. Every workbook having 3
(default) worksheets and you can add up to 255 worksheets and you can remove 1 or 2 worksheets
from the three. Worksheets contains 65,536 rows and 256 columns (numbered A to IV)..The
address of the cell is combination of row and column labels. Excel provides tool bars, menu
choices and functions. Other than these features excel provides Screen wizard, autocalc, auto
complete, templates, templates wizard etc

Microsoft PowerPoint

It is a presentation tool. We can create slides, handouts and speaker notes. The slides can be
arranged sequentially in presentations.

Microsoft Access

This is a powerful database program but you can store, retrieve, and organize data. Access comes
with wizards and variety of predefined database elements.

Microsoft Mail

Microsoft Mail is a product that comes with a license to use mail on the workstation where office is
installed. If your workgroup is using Microsoft Mail, this license allows to copy the necessary
software to your machine.

Microsoft Graph

Microsoft Graph is used to convert the tabular as well as text data into the graphs and charts. A
number of graphs and chart options are provided by this component of Office.

2

,
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Microsoft Clip Art Gallery

Clip Art Gallery is a collection of ready-made graphics that the user can import into any of the
primary applications to make them more effective.

Microsoft Word Art

Word Art enables a user to convert the text into various shapes for logos, banners, and headlines.

Microsoft Organization Chart

Microsoft Organization Chart provides the tools for creating figures such as organization charts by
selecting the different styles and organizations for charts.

Microsoft Equation Editor

Microsoft Equation Editor enables a user to format complex equations correctly.

Microsoft Publisher

It helps to organize the material of textbooks in the form of chapters and volumes.

5.2. Word Processing:
Using a computer to create, edit, and print documents is called word processing. Of all

computer applications, word processing is the most common. To perform word processing, you
need a computer, a special program called a word processor and a printer. A word processor
enables you to create a document, store it electronically on a disk, display it on a screen, modify it
by entering commands and characters from the keyboard and print it on a printer.

The great advantage of word processing over using a typewriter is that you can make
changes without retyping the entire document. If you make a typing mistake, you simply back up
the cursor and correct your mistake. If you want to delete a paragraph, you Simply remove it,
without leaving a trace. It is equally easy to insert a word, sentence, or paragraph in the middle of a
document. Word processors also make it easy to move sections of text from one place to another
within a document, or between documents. When you have made all the changes you want, you
can send the file to a printer to get a hardcopy.

5.3. Features of word processing:
Insert text: Allows you to insert text anywhere in the document.

Delete text: Allows you to erase characters, words, lines, or pages as easily as you can erase
them on a black board.

Cut and paste: Allows you to remove (cut) a section of text from one place in a document and
insert (paste) it somewhere else.

Copy: Allows you to duplicate a section of text.

,
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To insert new text, just click the mouse at the point where you want to insert the additional text and
start typimg.Existing text moves to accommodate your additions.

Type <C'rl + Home> to move to the very beginning of your document.

Deleting Text
The Backspace key deletes one character to the left of the insertion point. The Delete key deletes
one character to the right of the insertion point. You can use these keys any time. To delete more
than just a few characters, select the text and press the Delete key.

Undoing Mistakes
If you have accidentally deleted an important paragraph, use the Undo command under the Edit
menu immediately (The keyboard shortcut is < Ctrl + Z ». The deleted portion of the text is brought
back. This command can bring back the deleted contents only if you have not pressed any other
key in between,

6.4. Selecting Text:
You select a portion of text in order to perform some operation on it. You can then delete, replace,
copy, move, or format it. The Selection Bar is located to the left of the document window. When you
put your mouse pointer, which is a left pointing arrow in that area, the arrow swings to the right. The
following table gives the process of selection of text contents.

'IL.I\JUU',c-,,,,,ckthe right-pointing arrow in the selection bar to the left
the paragraph, or triple-click in paragraph.

ick at one end of the block and shift-click at the other end of the
ock. Or click at one end of block and drag to the other end of the
ock.

< Ctrl + A> or hold down the Ctrl key and click in the
Ilselecitionbar.

1I.....'''TT_.r''r'"'' an additional block. For example, if you have selected a
ragraph and you shift-click on another paragraph, it will be added
the selection.
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6.5. Cut, Copy and Paste Text:
You can copy selected text from one place to another with the Copy and Paste commands.
Cut - The Cut command extracts the selected text and puts it on the Clipboard (a temporary
storage area). The contents of the Clipboard are overwritten with each copy or cut. This can be
done either by selecting Edit from the menu bar and opting the cut option in it. Alternative usage of
the short cut key is CTRL +X.

Copy - The Copy command puts a copy of the selected text on the Clipboard. By selecting the Edit
from the menu bar and opting the Copy option in it. Alternative is usage of the short cut key is
CTRL + C.

Paste - The Paste command inserts the Clipboard's contents at the insertion point. The text that
has been selected using Cut! Copy command will be pasted at the insertion point. Existing text
moves to accommodate pasted text. By selecting the Edit from the menu bar and opting the Paste
option in it. Alternative usage of the short cut key is CTRL + V.

6.6. Paste Special:
Paste Special is a way to paste information from one application/document to another. The Paste
Special dialog box allows you to paste information in different ways. Choose Paste Special from
the Edit Menu.

You can paste in the information in several ways:

Formatted Text, Unformatted Text, Picture Object.

When we paste Formatted Text, it will paste all formatting (such as Bold, etc.) along with the text.
When we use Paste Special option the formatted text can be pasted as unformatted text or an
object.

6.7. Find and Replace:
Word allows us or helps us to search for a word in a document

Find: Find is used for searching a word in your document.
1.0n the Edit menu, click Find.
2.ln the Find what box, enter the text that you want to search for.

Replace: Replace is used to replace the searched word by another text.
Click On the Edit menu, click Replace.

In the Find what box, enter the text that you want to search for.
In the Replace with box, enter the replacement text.

The other options you have are Replace, Replace All, Find Next and Cancel.
Replace button replaces a word selected, at the first occurrence of the word in your document after
the insertion point.
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Replace All button replaces all the searched words in your document.
Find Next button searches for the next occurrence of the word being searched.
Cancel button cancels the search process.

6.8. Undo and Redo:
Undo

When working in Microsoft Word you will often commit mistakes. Instead of manually trying to undo
these actions you are able to rectify the mistake just by clicking the Undo button on the Standard
toolbar.
To practice the Undo Feature:
1) Press CTRL +End to move to the end of the document
2) Highlight the last paragraph in the document
3) Press the Delete key on the keyboard
To Undo the Previous Action:
Click the Undo button on the Standard Toolbar

Redo
You may aCCidentallyclick Undo too many times and thus, need to redo it. This command works
exactly in the reverse of Undo command.
To Redo the Previous Action:
Click the Redo button on the Standard Toolbar
Save and close the file.

6.9. Formatting Text and Paragraph
Microsoft Word allows you to format a document very easily. Without formatting, a document looks
very plain and may not get the attention that is desired.

font menu
jus1iti across page

numbered Md
bulleted lists outside border font color

style menu font size
left center IijIt
juslcatioo

increasel hig1llght ooI(J
decrease
indent

Figure 6.9a
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Making Font Changes
In Microsoft Word you are able to change the font size, color, type and attributes. Below we
demonstrate various ways to change the font.

Select a document of unformatted text for formatting.

Figure""
To edit the font style
1) Highlight the paragraph
2) Select Format menu
3) Select a Font type.
4) Notice the Preview window at the bottom of the dialog box, which displays the style of the font,
selected.
5) Click OK

Font Size
Opting the one of the numbers in size box does changing the font size for a selected portion of the
text.

Using Bold, Italics and Underline
Another way to make text stand out in a document is by using bold, italics and underline (or a
combination of these) formatting.
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in a Document
any word(s) in the document

the Bold icon on the Formatting Toolbar

ltalici<l~.Text in a Document
any word(s) in the document

the Italic icon on the Formatting Toolbar

Inl'llArlilnAText in a Document
any word(s) in.the document

the Underline icon on the Formatting Toolbar

F'n.'ftUllttil1ld1Paragraphs
1IJ1,,'rnc,n.Word, a paragraph is any amount of text followed by a paragraph symbol (10. A one­

h"' ....llr.n is a paragraph. A 100-word job description is a paragraph. Even a blank line
a ~ is a paragraph.

n.crrnrrn paragraph formatting from the Format menu.
paragraph you want to format.

c_o.__ • from the Command menu.
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Make the changes from the options that are displayed in the window. For example, to change line
spacing from single to double, click on the Line spacing drop down arrow, and choose double. You
can also choose options from the Formatting Tool Bar to format paragraphs.

6.10. Header and Footer
A header or footer is text or other information such as graphics that is stored at the top or bottom of
the page throughout your document. You can use the same header and footer throughout a
document or change for part of the document. For example, you can use your corporate logo in the
first-page header, and then include the document's file name in the header for subsequent pages.

To view Headers and Footers in Normal View, click View> Header and Footer. If you are in Page
Layout View (Word 97) or Print Layout View (Word 2000), simply double click the visible header or
footer that appears as gray text.

In either case, the Header/Footer toolbar appears.

Fa-mat Page Nunbe-

l=teviOJs
Svvitc:hBetvv'a3n

Same As I=t8IIiOJS

Figure 6.10

6.11. Bullets and Numbering:

Word has a feature of giving automatic numbers and bullets for paragraphs or for points. For bullets
fist select the paragraph or points to be bulleted and then select bullets icon form the standard
toolbar or select Format from menu bar and opt for Bullets and numbering. Select different types of
symbols as bullets.

6.12. Zooming:
The level of magnification of the text can be controlled by this zooming control. Choose percentage
value from the zoom popup menu and size of magnification of text.
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6.13. Page Break:

After allowing certain number of lines MS Word automatically inserts a dotted line in the document
called page break. We can insert a page break at any line in the document. Select Insert Menu
from menu bar and click break. Now the page break dialog box appears. Here select page break
button and click on it. Then page break will be inserted at the current cursor position.

6.14. Auto Correct and Auto Text:

Auto Correct

Auto Correct is used to correct the repeated typing mistakes. Select Tools menu from the menu bar
and click Auto Correct option, then activate Auto correct tab. Here type frequently misspelled words
in 'Replace box' and the correct one's in 'with box'. Click the Add button to add this to the
dictionary. Afterwards if we misspell a word, which was added to the dictionary, word will
automatically correct the mistake.

Auto Text

Frequently typed text can be placed into an Auto Text entry. First type the text what we want to put
into an Auto Text entry and then select it. Select Tools menu and Click Auto Correct and then
activate Auto Text Tab. Now, enter the abbreviation for the selected text and click OK. Afterwards,
if we want to type the text that is there in the Auto Text, simply type the abbreviation and click OK.
Then automatically the text will be typed without actually typing.

6.15. Page Setup:

Page Margins
The page margins of the document can be changed using the rulers on the page and the Page
Setup window. The ruler method is discussed,

Figure 6.15a
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first move the mouse over the area where the white ruler changes to gray.

When the cursor becomes a double-ended arrow, click with the mouse and drag the margin
indicator to the desired location. Release the mouse when the margin is set.

Figure 6.15b

The margins can also be changed using the Page Setup dialog box:
Select File/Page Setup and choose the Margins tab in the dialog box.

Enter margin values in the Top, Bottom, Left, and Right boxes. The Preview window will reflect the
changes. If the document has Headers and/or Footers, the distance this text appears from the edge
of the page can be changed. Click OK when finished.

Page Size and Orientation

Change the orientation page within the Page Setup dialog box.
Select File/Page Setup and choose the Paper Size tab.



Figure 6.1Sc

th.c,lnrnn.l:lOr paper size from the drop-down menu.
orientation from Portrait or Landscape by checking the corresponding radio button.

instructions to add page numbers to a document.
ne>•• rrn.l .. ",o numbers from the menu bar and the following dialog box will appear.

Figure 6.15d
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Select the position of the page numbers by choosing "Top of page" or "Bottom of page" from the
Position drop-down menu. Select the alignment of the page numbers in the Alignment drop-down
menu. If you do not want the page number to show on the first page (if it is a title page, for
example), uncheck the Show number of first page box. Click OK when finished.

6.16. Print Preview and Printing:

Preview your document by clicking the Print Preview button on the standard toolbar or by selecting
File/Print Preview. When the document is ready to print, click the Print button from the Print
Preview screen or select FilelPrint.

6.17.Summary:

At the end of this lesson you have learnt the important features of Ms-Word. We started with
procedure to invoke Ms-Word. We have identified toolbars available in the word. You learnt the
procedure of creating a new document and opening an existing document. Now you are in a
position to create a new document and can make corrections like deleting a character, word, line or
paragraph and replace with required text by using replace option. You can also move the selected
part of the text to another place by the "cut" anI'! "paste" commands. At the end of the lesson we
discussed the procedure of saving a document and exit from word.

You have gained the knowledge of formatting a document using different formatting options like
setting margins, changing the font size, and alignment to the text. The headers, footers, tabs,
indents make the document in presentable format.

6.18. Technical Terms:

Font
Font refers to the combination of a typeface (eg. Times Roman, Arial, Century Schoolbook) and its
attributes (bold, italics, size (12pts).

Bullets

Bullets are special characters or symbols that are used to set off a paragraph. Typically, each
bulleted paragraph is an item in a list, and it consists of the bullet symbol and indenting to set the
bullet apart from the text.

Document

A document is any data file that is created by a specific application.

Current Document

The current, or active document is the document you see on the Word screen.
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Drag-and-drop

Drag-and-drop is a feature that allows you to move or copy information without using the Windows
Clipboard. To use it, you simply drag a selected item from one location to another. It is best used
for moving or copying small items short distances.

Footer

A Footer is the contents of an area located within the bottom margin of a page.

Header

A header is the contents of an area located within the top margin of a page.

Justification

Justification determines how lines and characters within those lines are printed. With full
justification, all lines start at the left margin and end at the right margin.

Margin

The margin is the amount of blank space, usually measured in inches or characters, above and
below and to the right and left of the main body of a document.

Menu Bar

The menu bar contains the names of Word's menus and is used to navigate through their
commands:

Paragraph

A paragraph in Word begins where you start typing, and it ends where you press [ENTER].

6.19. Model Questions:
1. Explain about different components of MS-Word window.

2. Explain Find, Replace & Go To?

3. Explain Header and Footer?

4. What is the difference between Auto Correct and Auto Text

5. Explain the text formatting features in MS-Word
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Less.,n 7

Microsoft Word

7.0 O~jectiyes:

i
This le.on provides an introduction to the Views, Spell Checking, Tables, Macros and Mail merge.

Strucfure of the Lesson:

1.1. Views
7.2. Spell Checker
1.3. Word Count
7.4. Macro
7.5. Graphics
7.6. Lines and Shapes
7.7. Word art
7.8. Tables
1.9, Borders and Shadingt.10.Footnote and Endnote
7.11.Tabs
1.12.Mail merge
1.13.Format Painter
7.14.Summary
7.1S.Technical Terms
~.16.Model Questions
7:.17.References

;

7.1.Vi~ws:
Any document can be viewed in different fashions. These views can be selected from the view
menu of the menu bar.
Normal view is a default view for all new documents. However saved document will be opened last
saved view. For exarrple a document is opened in normal view and saved in page layout view,
when saved document is reopened, the document will be opened in page layout view.

NormalView
You can create and edit text or graphics normally. To work with header and footers you invoked
select itElll/Header and Footer. Footer details will not be displayed on screen.

1

7.3 Microsoft Word

You have sever~1choice.sat this point d~s~cribedin the table below. If the word is spelled correctly,
you can 'gnore It or add It to a custom dictionary by selecting the options. If the word is incorrect
you can use Replace it with one of its suggestions or with a spelling you type in the Change To: '
box.
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This view will not show side-by-side column positioning, footers and headers. Automatic page
breaks are shown as dotted lines. Manual page breaks containing the words" Page Break".

Page layout View
In this view headers & footers can be seen and edited. You can modify the Header/Footer by the
selecting the matter itself. It will display the left side scale also.

Outline View

This view is used to see entire contents of the document, chapter headlines and sections headings
if your document is properly formatted. It is useful if the document is large.

Print Preview
Print preview is another way to view a document. Choose file ~ print preview or Ctrl +F2. You can
see one page to six pages at a time in print preview.

Split Screen View
You can see two parts of your document at once. This feature is useful to make copying, cutting
and pasting quickly in both the documents simultaneously.

7.2. Spelling Checker:
To start the spelling checker, select Spelling and Grammar from the Tools menu. MSWord will
begin to check for misspellings. If a word is found that is not in its dictionary, it pauses, displays the
word, and if possible, suggests alternatives (see figure below).

Figure 7.2

2
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Runninp A Macro

To run an existing macro, follow these steps:

Figure 7.4c

Select Tools/Macro/Macros from the menu bar.

From the Macros window, highlight the Macro name in the list and click Run.
If the ma~ro is long and you want to stop it while it is running, press BREAK (hold CTRL and press
PAUSE).,

.1'"~'.'.""."""."..'.'.<.' dIPIo:t: .......
]!i........
",. ,.
<f. ....
'l';' WIIII)OW$ifi.~~ ."".WIIb~

Figure 7.5.
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7.S.Graphics:
Microsoft Word contains a full set of graphic tools. You can:

Create graphics from scratch.

Import graphics from other programs.

Place graphics within text.

Manipulate graphics on a page.

Word comes with some pre-designed graphics that are normally installed in the MS OFFICE\CLlP
ART folder. These graphics can be resized and placed within text.

Inserting a Graphic in your Document

To insert a graphic in a document position the insert point where you want to place the graphic in
the text. Select Picture from the insert menu. Click on Clip art, and double-click the graphic you
want to insert.

Choose Insert, Picture, Clip Art or click the Insert Clip Art button on the Drawing toolbar.

Word opens the Clip Art Task Pane.

Search for a specific clip image by entering what you are looking for within the Search field in the
Task Pane.

Alternately, click on the Clip Organizer button toward the bottom of the Task Pane to open up the
Clip Art Organizer.

Select a clip and when Word shows a control palette, select the first option, Insert Clip. The clip is
inserted where your insertion point is positioned.

You can also drag the clip art into your document.

Wrapping Text around a Graphic

By default text does not wrap around a graphic. To get text to wrap around a graphic, do the
following:

Right click on the graphic to get the short cut menu.

Choose Format Picture from the list displayed.

Select the Layout tab.

Choose the style of wrap that you like and click OK.

6
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Resizing a Picture

Select the inserted picture by clicking once on it.

Click the Cropping tool on the Picture toolbar.

Notice that the mouse cursor has changed.

Drag one of the corners with the pointer to reduce its size and eliminate it.

7.6. Lines and Shapes
Use the Drawing toolbar to create lines, shapes, text boxes, AutoShapes, WordArt, or Clip Art.

Drawing a Line or Arrow

Open a new Word document. Click the Drawing tool in the Standard toolbar or right click in any
toolbar on your screen to display a list of available toolbars. Select the Drawing toolbar. Click a line
or arrow on the Drawing toolbar. When the cross hair (+) appears, point to a spot in your document
where you want the line or shape and draw a shape.

Drawing an AutoShape

Click AutoShapes on the Drawing toolbar. Select Stars and Banners from the drop down list of
categories. Select the shape you want. Click in your document and drag the cross hair that appears
to draw the shape.

Adding a Text Box:

Click the Text Box icon on the Drawing toolbar. When the cross hair appears, point to a spot in your
document where you want the text box and drag. The box appears with an insertion point in it. Type
"Microsoft Word Graphics" within the box.

7.7. WordArt :
To display the Word Art Gallery, choose Insert, Picture, WordArt or click the WordArt icon on the
Drawing toolbar. Double-Click a WordArt style. Word opens the Edit WordArt dialog box. Type the
text you want and it will replace the sample text. Choose a font, font size, and style. Click OK to
close the WordArt Gallery and see your text.

7
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01( Cancel

Figure 7.7

7.S. Tables:
Creating Tables Using the Menu

A table is a grid of rows and columns on the page, like a spreadsheet. The area where a row and
column intersect is called a cell. The number and width of columns can vary from row to row. Cells
are separated by gridlines, which are non-printing separators. To display the table gridlines, select
Gridlines from the Table menu.

Each cell can contain a paragraph, multiple paragraphs of text, or graphics. Microsoft Word wraps
text within a cell in the same way that text is wrapped at the end of a line of normal text. Text within
cells can be formatted, copied, cut, and pasted. You can add text, edit text, change its size, add
borders, or add and delete columns and rows.

To create a table, select the Insert Table command from the Table menu. The Table Dialog box
appears: enter the number of columns and rows you want to include in the table and click on the
OK button. A table with the number of columns and rows that you specified is inserted in your
document and the cursor is positioned in the first cell of the table. You can move from cell to cell
using the <Tab> key, to move forward to the next cell and the <Shift Tab> keys to move back to the
previous cell.

Creating a Table Using the Table Button in the Standard Toolbar

The Table button on the Toolbar provides another way to create a table. To use the Table button,
place the mouse on the Table button and press the mouse button. The Table button selection box
pops down. Drag the mouse down to select the number of rows you want ana to the right to select
the number of columns. When you have selected the correct number of rows and columns, release
the mouse button. A table with the number of cells you have specified is lnsertec in your document.

8
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Selecting Tables

Cells in a jible can be selected using the click-and-drag method or one of the following techniques:

Iro select a Click in the lower left comer of the cell. (The mouse pointer shape
cell: becomes a right pointing arrow.)

Iro select a Single Click in the selection bar to the left of the row.
ow:

Iro select a Place the mouse on the top border of the column and click. (The mouse
column: pointer becomes a black down pointing arrow.)

n-0 select the pn a Macintosh hold down the Option button and double-click in the
lentir, table: able. On a Windows machine Press the <Alt> key and the number 5 key

:
on the numeric keypad . (The NumLock must be turned off.)

Ir0 select more Drag the mouse across the desired cell selection.
han one cell:

Inserting Columns and Rows

To insert a row or column within a table, select Insert Row or Column options from the Table menu
and position the insertion point in the row/column you want to insert.

Changing Column Width

You can adlust the width of a column, or you can adjust the width of all the cells in a column. To
change the column width, click Ott the column width button. Drag the button to the left or right
according to your needs. To chaA8~ the width of all the columns select the entire table and drag the
column wijjth button you wish to change.

ColumnIM~ Handles

Click and drag the first column width button to the 1.5-inch mark. Click on the Next Column width
button to the 3-inch mark. The mouse can also be used to change column widths. To select the
column that you want to change, place the mouse pointer on the right border of the column. As you

9
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move the mouse pointer on top of the column border the pointer becomes a two-headed arrow (see
example). When the mouse pointer is displayed as the two-headed arrow, press the mouse button
and drag to reposition the column width. As you drag the mouse, an outline of the new border
shows the border position. When you have resized the column to a satisfactory width, release the
mouse button. The entire column is resized accordingly.

Deleting Columns and Rows

To delete a column or row, select the column or row you want to delete then select Delete column
or row from the Table menu. Notice that if you select a column, the command is Delete Columns. If
you select a row, the command is Delete Rows.

7.9. Borders and Shading:

You can add a border to any or all sides of each page in a document, to pages in a section, to the
first page only, or to all pages except the first. You can add page borders in many line styles and
colors, as well as a variety of graphical borders.

7.10. Footnote and Endnote:
Footnotes and Endnotes are used in printed documents to explain, comment on, or provide

references for text in a document. You can include both Footnotes and Endnotes in the same
document - for example, you might use Footnotes for detailed comments and Endnotes for
citation of sources. Footnotes appear at the end of each page in a document. Endnotes typically
appear at the end of a document.

10
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1. In print layout view, click where you want to insert the note reference mark.

2. On the Insert menu, click Footnote.

3. Clial<Footnote or Endnote.

4. Under Numbering, click the option you want.

5. Click OK.

Word inserts the note number and places the insertion point next to the note number.

6. Type the note text.

7. Scroll to your place in the document.

7.11. Tabs:
By using tab key on the keyboard we can move the cursor by a fixed distance in the

document. By default, every tab press, the cursor moves half-inch. But we can create our own tab
positions. For creating customized tab positions first we have to select the tab alignment button at
the left hand side corner of the ruler line. Tabs can also be created, by using the tab dialog box.
Select Format menu from the menu bar and click tabs option. Then we get Tabs dialog box. Here
we select the type of the tab and distance and click OK. button. Then the tabs will be set
accordingly. Here by using tab dialog box we can also create one more tab i.e., bar tab. By this we
can create a vertical line in the text at the specified bar tab position.

7.12. Mail Merge:
Mail Merge is used to quickly create form letters, mailing labels, envelops and catalogs by merging
the information from two different files. Those two files are generally the Main Document and Data
Source File. After creating those two files, they are merged to get the desired result. Generally mail
merge is used to print multiple copies of a particular letter addressed to many members. For
example Circulars, Greetings & Invitations will come under mail merging.

Main Document

The main document contains the subject matter of the letter to be printed. It can contain text,
graphics objects and fields (data), which are to be inserted in to the letter. When merging, data will
be merged with the main document.

Data Source

Data Source file contains the information in the form of records, which is to be inserted to the main
document. In one record, one member's information is stored - for example one person's address.

11
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The individual information in the records is called a field. Actually the data written in these fields will
be inserted in the main document during merge.

Merge requires 3 steps

Creating Main Document

Creating Data Source

Merging two files.

Creating Main Document

First, Open a new document to create a main document by selecting File~New. Then select
Tools-sMail Merge. The following dialog box will be displayed on screen:

Click on the "Create" button to display the available formats (form letter, mailing labels, envelopes
or catalog) of the main document. Then a dialog will be displayed prompting where to create the
main document (whether the active window or a new document). Click on "active window" to create
the main document in the active window.

12
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Creating qata Source

To create. data source file click on Get Data in Data Source. The following will be displayed. Click
on Create pata Source to specify the fields to be included in the address, like name, place etc.,

The eXisti~'g field names will be displayed on the screen to the right. Unwanted fields can be
removed clicking on the field name and by clicking on the field name and by clicking on the
button "re ove field name". If any new fields are to be added, type the field name on the left side.
After spec. ing the field names, to type the contents, click on ok. A dialog box will be displayed to
specify a name for the data source. Type the name and click on "Save". A dialog box is displayed
asking to ~dit the data source or edit the master document. The following diagram specifies the
same:

Type the details by pressing enter after typing the first name, job title etc., for this, click on
"Add new1-After typing all the details click on OK. Add contents to the document. Insert the merge
fields in the window document. Finally select tools-small merge. Merge dialog box will again get
displayed~click on "Merge".

7.13. F~rmatPainter:
The Forniat Painter is a button on the Standard toolbar. It makes it easy to copy all the formatting
features cf one paragraph to one or more paragraphs.

To copy ttjle paragraph formatting using the Format Painter you will:

1. Highlight the paragraph whose format you want to copy.

2. Nqw click the Format Painter button on the Standard toolbar.

o If you press the button once, you will be allowed to copy the format to only one
paragraph.

13
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o If you double-click the button, the button will stay depressed and allow you to copy
the format to as many paragraphs as you want. When you are finished you must
then click the Format Button once in order to turn off the feature.

3. Notice that your insertion point now has a Paint Brush attached to it. This indicates that the
format of the selected paragraph may be painted or copied onto another paragraph.

4. Place your insertion point anywhere within the paragraph that is to receive the format and
click the left mouse button. At this point the format of this paragraph will change.

7.14.Summary:

In this lesson we discussed the procedure of inserting a table in the document. You can insert a
table of required number of rows and columns. In this lesson you have learnt the concept of mail
merge and its usefulness. The mail merge feature supports many word processors that enable you
to generate form letters. The mail merge feature of Ms-Word requires mainly two components: the
main document and the data file. The main document is the body of the letter that has to be sent.
The data file contains the list of names and addresses in the form of rows. You have learnt the
procedures of creating the main document and the data file, and combining them.

You have observed how to use spell checker, the macro capability, and working with the graphics
like ClipArt, WordArt, Format Painter, Footnote and Endnote features.

7.15. Technical Terms:

ClipArt

ClipArt consists of pre-designed images that can be placed within a document.

Data Form

A data form is a dialog box that allows you to view and edit individual records in a database.

Data Source

A data source contains the information from which a merged document is created. The data source
is merged with a main document, which specifies the kind of output required.

Database

A database is a collection of organized information.

Dictionary

Word uses two kinds of dictionaries, a main dictionary and a custom dictionary. The main dictionary
cannot be altered; we can add words to the custom dictionary.

14
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Mail Merge

Mail Merge refers to the process of combining a data source, and a main document to produce a
unique output.

Wizard

A wizard i$ a feature of Microsoft applications that lets you work through a series of dialog boxes to
help you complete a task.

7.16. Model Questions:

1. What is a macro? Explain the procedure for creating a macro?

2. How do you perform mail merge?

3. Explain the difference between Footnote and Endnote?

4. Explain the procedure to create a table?

5. Explain different views in Ms Word?

6. Explain the graphic facilities in MS-Word ?

7.17.Refereneces:

RON MANSFIELD, 'Working with MS OFFICE', Tata Mc Graw HiII- 2000 Edition

GUY HART DAVIS, ' The ABC'S Of Microsoft Office. ' BPB Publications, New Delhi

MS OFFICE 2000 Complete, BPB Publications, New Delhi

Y. SURESH BABU, M.Com., M.C.A.,
Lecturer, Dept.Of Computer Science,
JKC College, GUNTUR.
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Lesson 8
Microsoft PowerPoint

8.0Objective:
This lesson introduces the basic features of Microsoft PowerPoint, Creating Presentations, View
options, Inserting new slides and setting background color scheme to the presentation.

Structure of the Lesson:

8.1. PowerPointbasics
8.2. Startinga presentation
8.3. PowerPointwindowproperties
8.4. Savea PowerPointpresentation
8.5. CopyandMovedataIna PowerPointpresentation
8.6. Viewoptions
8.7. Addaslide
8.8. AddlModifytext
8.9. Bulletstyles
8.10. Speakernotes
8.11. Background/Colorscheme
8.12. Slidemaster
8.13. Headers/Footers
8.14. Summary
8.15. TechnicalTerms
8.16. ModelQuestions
8.17. References

8.1. PowerPoint Basics:
PowerPoint is an application that lets you build, print, and deliver presentations. You have

several options for the delivery of a presentation, but you only have to develop it ....ce. You can
print slides, print handouts, print notes pages, prepare for 3Smm slides, or deliver an on-screen
presentation. Only the on-screen presentation allows you to use the full range of PowerPoint's
features.
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As you develop a PowerPoint presentation, it is important to remember that you should not
try to include every piece of information you wish to deliver. PowerPoint slides should contain brief,
concise, descriptive phrases that will help you remember what you want to present and to serve as
a reminder for your audience.

8.2.Sta~ing A Presentation:
Start PowerPoint by either of two methods:

1. Go to the Start menu. Choose Programs and then click on Microsoft PowerPoint.

2. Double-click the icon of any PowerPoint document. When you double-click a PowerPoint
document, PowerPoint opens with the document already loaded.

A PowerPoint presentation consists of slides that can contain text, graphics, charts, and other data
types. When you start PowerPoint, you can start with a blank presentation, or you can begin from a
template or use the AutoContent Wizard.

The AutoContent Wizard is series of step-by-step instructions designed to assist you. The Template
button to h~lp accesses slide templates create a consistent, professional look for your slide
resentation.

·X

y x

Click to add subtitle
-...!ll_.'_,

ilr .... Q'I~ .. 1ihl,<,f]'_m-

Click to add title

-••• .:.1. 'I_'~-J' .OOlil"O!llIi1!~·"'·A.··~~.e.•• • __ ~f,I.S.)

OAdlS~",," ...

==='4 (i)--­~:$h&Mo."'"

New Presentation Dialog Box

AutoContent Wizard walks you through a series of questions designed to elicit information about
you and the type of presentation you are making. The Wizard then builds a dummy presentation
that will guide you in developing the content of the presentation.



Icomputer Based Documentation 8.3 Microsoft PowerPoinij

Design Template allows you to establish the background and color scheme from the available
templates prior to beginning work in the new presentation. Template choices are generally easier to
make after you have opened the new presentation because you can better see the characteristics
of each template before making a selection.

Blank presentation opens a new presentation with no template. Open an existing presentation
displays a list of recently opened PowerPoint presentations from which you can choose. Or, you
may choose More Files to move to the location of a previously saved presentation file and open it.

AutoLayout

After you have opened a new presentation, PowerPoint displays the New Slide dialog box
containing several Auto Layouts. Auto Layouts provide a pre-determined layout for each specific
type of slide. They provide consistency throughout the presentation. Each layout depicted is
described in the lower right corner when you click the layout. This sample New Slide dialog box
shows the Title Slide selected (denoted with the thick border).

10&1

New Slide Layout Dialog Box

8.3. PowerPoint Window Properties:
The Microsoft PowerPoint window has many of the same attributes as other windows in the

Microsoft Office Suite. The table below lists the different features and provides a brief description of
each one.
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Besides the usual window components, the PowerPoint window has several unique elements,
identified in the figure below .

.......
-.... Click to add title

Click to add subtitle

Menu Bar

The words listed atop the application window, immediately underneath the Title bar. You can
access all application commands from the Menu bar

Standard Toolbar

The Stamdard toolbar, located beneath the menu bar, has buttons for commonly performed tasks
like printing, saving, inserting clip art, and other operations. You can customize the toolbar or even
display multiple toolbars at the same time.
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Formatting toolbar
The Formatting toolbar, located beneath the Standard toolbar bar, or possible to the side of it, has
buttons for various formatting operations like changing text size or style, changing alignment,
formatting bullets, and animation
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Drawing Toolbar
The Drawing toolbar on the bottom of the PowerPoint window contains drawing and text tools for
creating graphics.
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Slide Layout Task Pane

The area on the left side of the window that allow you to easily switch between the Outline and the
Slides views.

Slide Area

The area in the middle, in which you actually work on your presentation slides

Task Pane

The area on the right side of the window that allows you to easily access various commands. You
can display different Task Pane options by clicking on the dropdown arrow in the upper right-hand
corner of the pane.
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8.4. Save a PowerPoint Presentation:

Changes you make to a document are not saved to disk until you issue a Save command.
Saving is quick and easy, and you should save often to minimize the loss of your work. PowerPoint
has two save commands, Save and Save As, that work similarly. Both commands are on the File
menu.

Save
When you save a new presentation for the first time, PowerPoint displays a dialog box similar to the
Open dialog box. Select the disk in which to save the presentation and specify a name for the file.
When you save an existing document that you have been editing, the newly saved version replaces
the older version.

Save As
This command displays a dialog box where you can choose a document name and destination
folder or disk. Use the Save As command whenever you want to save a copy of the current
document with a different name or in a different folder or disk. The newly saved copy becomes the
active document

A presentation is normally saved as name.ppt file type. However, PowerPoint Show with the
extension of name.ppt is also a useful file type so that your file is able to run regardless of operating
system.

8.5. Copy and Move data in a PowerPoint Presentation:

Use the Copy and Paste commands to copy selected text and graphics from one slide to another. If
you want to move data instead, use the Cut and Paste commands. To do this:

• Select the text you want to cut or copy by highlighting it.

• Go to the Standard Toolbar to choose the Cut or Copy short cut icon.

• Move and click your mouse to the place where you want the text to go. Note the cursor is
blinking.

• Go to the Standard Toolbar to choose the Paste short cut icon.

8.6. View Options:
Power point offers different views for entering, editing and previewing your information. They are:

• Slide view
• Outline view
• Slide Sorter view
• Notes Pages view
• Slide show view
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Slide View
Slide view shows how our listed slides will work. We can move from one slide to another with pg up
and pg dn keys. We can edit text and other slide elements in slide view.

Outline view
It will display all the text in the presentation. Here we can easily rearrange line item. We collapse
items in this view so that we can see important headings or names of each slide.

Enter and Edit Text in Outline View:
PowerPoint's Outline Area lets you focus on the content of your presentation, by typing up the
outline prior to laying the presentation out. After you type an outline, you can concentrate on how
your presentation looks

The boundary of the Outline Area can be resized by dragging the vertical separation to the right.
This will make it easier to enter your outline.

Entering Slide Titles and Bullets:
Typing in PowerPoint's Outline view is similar to using a word processor. Type your slide title or
bullet point and press Return to start a new slide or bullet. To force a line break within a slide title or
bullet, press Shift-Enter. This starts a new line for the same title or bullet.

Move Slides in the Outline Area:

It's easy to change the order of your slides and bullets in the Outline Area. Press the mouse button
on the item you want to move and drag it to the desired location. You can also select the item you
want to move and click on the Move Up or Move Down buttons.

Delete Slides or Bullets:
While working in the Outline Area, you can delete a slide by clicking on the slide icon next to the
title and pressing the Delete key. Delete bullets and sub bullets similarly.

Slide Sorter view
It will show the slides in reduced size. We drop the sliders to move the slides so that we can
change the order of slides. We can make the slides appear and disappear using the effects.

Notes Page View
It is to create and see notes to the presenter. It shows miniature slide image and provides a text
area for presenters notes.

To enter notes
1.Click on the text area shown below this line. The box outline will change appearance.
2. Type and edit in the note box.

Slide show view
It will show the slides in reduced size. We drop the slides to move the slides so that we can change
the order of slides. We can make the slides appear and disappear using the effects.
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When you right click on the slide it will show some options. In that we can opt 'Pen' to draw the
temporary lines. These lines will not be saved on the slides. To leave from the slide show press
Esc.

Zoom

The Zoom adjuster lets you alter how large your slides appear on the screen relative to full-screen
presentation mode. Click on the Zoom drop-down list (in the toolbar near the top of the screen), or
click on the View menu, and select Zoom ... Select "fit", a default percentage, or type in your own
number, according to your needs.

8.7. Add a Slide:

In the Text Outline area, you can add a slide before or after an existing slide.

• To add before a slide position the cursor at the beginning of text of the slide in front of which
you would like a new slide, and press the Enter key.

• To add after a slide, position the cursor at the end of the text of the slide after which you
would like a new slide, and press the Enter key (if you had indented levels of text on the
previous slide, use the Promote (left arrow) button in the toolbar at the top of the screen to
move the text back to the left to force a new slide...

In Normal, Outline, Slide, or Slide Sorter view, select the slide after which you wish to insert a
new slide.

• Then click on the Insert menu, and select New Slide.

• When you add a new slide this way, the New Slide window appears, asking you to select a
slide layout.

• Select whichever layout is appropriate for the content you will place on the new slide. The
one selected in the example on the right is "Bulleted List". If the provided layouts don't meet
your needs, select the bottom-right layout, "Blank", which will provide you with a new empty
slide. However, no matter which layout you choose, you will be able to modify it later.
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8.8. Add/Modify Text:

Here are a few ways to insert or modify text in PowerPoint:
• In Normal or Slide view, select the slide on which you wish to insert text. If there is already

a text box on the slide you may click your mouse on it and start typing. Familiar word
processing tools for modifying text (color, style, font, alignment, etc.) are provided.

• In Normal or Slide view, to add a new text box to a slide, click on the Insert menu, and
select Text Box. Put your mouse over the slide layout - the cursor will change to a narrow
down-arrow (as shown on the left below). Click, hold, drag, and release the mouse to form a
rectangle on the slide. Then you can type into the text box created for you (as shown
below).

!f'///////..aw/////~
I % I %+ ~//////4:Y///////..a

• To work directly in the Text Outline area, position the cursor at the point where you would
like the new text to appear and just type it in. Use the Promote I Demote buttons in the
toolbar at the top of the screen to create different levels of indentation...

8.9. Bullet Styles:
Although you can set Bullet Styles in the Master, you also can change the bullet style on

any slide or on any bulleted point. When you change the bullet style, every subsequent bullet on
that slide, whether promoted or demoted, will have that style until you change back to the default or
change to a different slide.

To change the bullet style, make sure the cursor is in the line of text in which you wish to change
the bullet, then choose FORMAT: Bullet.
NOTE: Sometimes it is difficult to remember exactly what the default bullet style was, so pay close
attention to the selected bullet before proceeding with any changes.
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, Format Bullet Dialog Box
You can c~.oose from the selections provided by PowerPoint, choosing both the size (in percentage
of text siz~ and the color.

Click Character to include any symbol font installed on your system. Keep in mind, however, that if
you choose a font that is not installed on the computer from which you are giving your presentation,
the preseritation computer will choose the "closest" font to the one you chose and the result may
not be on~ you like. Both Symbol and Wingdings font are standard on most computers and should
display as ~ou intended.

Adding I ~emovingBullets

[§1he B~lIet Tool is a toggle. Click it once to place a bullet at the beginning of the current line of
text (the ore in which the cursor is flashing). Click it again to remove the bullet. This way you can
add bullets to text you have typed without using the Bullet AutoLayout.

8.10. SReaker Notes:
PowerPoirlt has a facility for adding speaker notes to a presentation. These can be notes that you
create for yourself - for example, to help you remember key points during a presentation - or you
can create them as additional information for your audience. After you have completed a
presentatlon, you can print the notes for each slide, along with a smaller version of the slide. To
add notes to a slide:
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• Click on the View menu, and select Notes Page (you may want to adjust the Zoom
percentage to get a larger view).
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8.11. Background I Color Scheme:
Design templates contain color schemes, slide and title masters with custom formatting, and styled
fonts, all designed to create a particular look. Not only can you specify a design template when you
begin a new presentation, you can choose a design template (for the whole presentation, not
individual slides) any time while editing a presentation. To do this, click on the Format menu, and
select Apply Design Template. A window will open asking you to choose a design. Select one and
click Apply. The name of the template chosen will be displayed in the center of the status bar at the
bottom of the PowerPoint screen. If the status bar is not visible, click on the Tools menu, select
Options, click on the View tab, and ensure that Status bar is checked.
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The background color of slides can be customized by clicking on the Format menu I Background.
Click on the drop-down list to select either another color from the subset provided or click on More
Colors and Fill Effects to see other choices. One of the Fill Effects available is Picture (import an
external image file to use as a slide background). When you are done, click on Apply (if you wish
to alter just the current slide) or Apply to All (to alter all slides at once).

Background [-7It X I
rBackgroundfIII--­

<> Title of Slide
• Bullet text

Apply to AD I
I Apply I

Cancel I
Preview I

More Colors,,,

EJII EfFects,,,

The color scheme for slides can be customized by clicking on Format I Slide Color Scheme.
Either chooses a preset scheme from the Standard tab or click the Custom tab, click on the
desired component (e.g. Background), and click Change Color (a color selection window will
appear). When you are done making color choices, click on Apply (if you wish to alter just the
current slide) or Apply to All (to alter all slides at once).

8.12. Slide Master
The Slide Master in a template is a slide that controls the formatting, text, and objects that

appear on every slide in your presentation. For example, if you want a small picture of the world to
appear on every slide, place that picture on the Slide Master. To display the Slide Master, choose



1C0mputerBased Documentation 8.13 Microsoft PowerPoin~

Master/Slide Master from the View menu. You can then edit this slide. Changes you make to the
Slide Master also appear on each slide in your presentation.

It is easy to edit the text of a slide in the Outline Area. However, to modify a slide's
appearance, switch to Slide View. If you want your changes to apply to every slide in the
presentation, choose Master/Slide Master from the View menu.

In Slide View just click on an object to select it. Then use the Format menu to apply the
change you want. For example, to change the font or color of the slide title, select the slide title and
choose Font from the Format menu. The Format menu also has commands for centering or left
aligning text (Alignment), and changing colors (Colors and Lines). You can even change the format
of slide bullets using the Bullets command on the Format menu. PowerPoint also has a Formatting
toolbar to simplify basic formatting tasks.

» Fifth level

. Click to edit Master title sty le .
: .Tl~l~.~r!l.~.~9!.~\l~'!!~!!'t'~I,1~~j
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:. Click to edit Master text styles
- Second level

• Third level
- Fourth level
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Sample Slide Master

8.13. Headers I Footers:
• On the View menu, click Header and Footer.

• On the Slide tab, you set options, the effect of the options selected will appear at the
bottom of slides:

o Date and time can be set to Update automatically (to reflect the last date the
slides were modified) or Fixed (type a certain date such as when the presentation
will be given).

o Selecting the Slide number option will automatically insert a sequence number.

o Selecting Footer (and typing text in the box below it) inserts fixed footer text.
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o Selecting Don't show on title slide will omitthe footer from the title slide (but it will
appear on the other slides).

o Normally you click on the Apply to All button to make these changes throughout the
presentation, but of course you can click Apply to affect just the current slide.

• Sifnilar options are available on the Notes and Handouts tab, plus the option of adding a
pape header to your printouts.

8.14. Su~mary:
At t~ end of this lesson you have learnt the important features of Ms-PowerPoint including

creating a Jtesentation, opening an existing presentation and working with different kinds of slide
layouts. We¥dentified different toolbars available in PowerPoint.

You are in alposition to format the text, applying background color to the presentation, working with
master slidej applying speaker notes to slide, applying header and footer to the document.

8.14. Te~nical Terms:,
Slidet Brief, concise, descriptive phrases that will help you remember what you want to

present and ~ serve as a reminder for your audience.

powerpointJ.!'resentation: PowerPoint presentation consists ·of slides that can contain text,
graphics, ch" LS, and other data types.

Slide Maste~: The Slide Master in a template is a slide that controls the formatting, text, and
objects that appear on every slide in your presentation.
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Speaker Notes: Speaker notes can be notes that you create for yourself, key points during a
presentation, additional information for your audience.

8.15. Model Questions:
1. What are the features of PowerPoint?

2. What is a Slide? Explain the procedure to create a Slide?

3. What is Slide Master? Write the procedure to create Slide Master?

4. Explain the procedure to create Header and Footer in PowerPoint?

5. Explain the views available in PowerPoint?

8.16. References:

RON MANSFIELD, 'Working with MS OFFICE', Tata Mc Graw HiII- 2000 Edition

GUY HART DAVIS, 'The ABC'S Of Microsoft Office.' BPB Publications, New Delhi

MS OFFICE 2000 Complete, BPB Publications, New Delhi

C.V.P.R.PRASAD, M.C.A.,

Lecturer, Dept.Of Computer Science,

JKC College, GUNTUR.
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Lesson - 9

Microsoft PowerPoint

9.0Objective:
This lesson introduces the Drawing Objects, Images and ClipArt, Audio and Video, Slide
Transition, Rehearse Timings and Charts.

Structure of the Lesson:

9.1. Working with Text
9.2. Drawing Objects
9.3. Imagesand Clip Art
9.4. Audio and Video
9.5. Creating Hyperlinks
9.6. Animating the presentations
9.7. Slide Miniature

'.B. Slide Transition

'.9. Slide Show Animation
9.10. RehearseTimings
9.11. Slide Setup and Printing
9.12. Charts
9.13. Summary
9.14. Technical Terms
9.15. Model Questions
9.16. References

9.1.Working with Text:
Any time you wish to make formatting changes to text, you must highlight the text to be
changed. Making a selection from the Text Toolbar affects the highlighted text only. In
addition to the standard text formatting tools of font choice and size, bold, italics, and
underline, you also can align text left, center, or right. Other special tools are described
below.

ShadowedText
The Shadow Text Tool places a slight shadow behind the text. Although the effect is not
prominent, this is an excellent tool to use to give more definition to title text. You should
NOT shadow all body text since this makes it very "muddy" to read.
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olling~~9rth
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Sample Shadowed Text

To shadow text,

1. Type the text to be shadowed.

2. Highlight the text.

3. [!blick the Shadow Tool.

Increase / Decrease Paragraph SpaCing

I::: ~~~he Increase and Decrease Paragraph Spacing Tools expand and contract
paragraph spacing, respectively.

Format Painter

~he Format Painter Tool picks up any formatting applied to existing text and applies
that same formatting to any text it is "painted" over. The two pieces of text need not be on
the same slide. .

To use the Format Painter,

1. Htghlight the text containing the formatting you desire to "pick up".

2. Click the Format Painter Tool.

3. Press and drag over the text as you would to hiQhtight it. The formatting will be
applied.

After the formatting is applied the Format Painter will de-select
To apply formatting to multiple selections of text without needing. to click the Format
Painter between each application, double click the Format Painter. The Painter will remain
the selected tool until you click it to de-select, allowing you to press and drag over multiple
sections of text, applying the same format to each.

Increase/Decrease Font Size
,~ A'"
ft. You can increase or decrease the font size of highlighted text by clicking on
the Increase Font Size or Decrease Font Size Tool, respectively. Size increments and
decrements by the standard font sizes.
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Tett Colors

!aOa.lyouchoose text colors with the Font Color Tool located in the Drawing Toolbar.
Highlighted text will change to the color displayed in the band beneath the A.

To make additional color choices or to see additional non-scheme colors you have used in
this.presentation, click the drop-down arrow beside the A.

Current Selected
Color

0101$in the Current
Design Scherne

ditional cololS you
molYhave chosen in
th is Pr@sentation

More font color
choices

Font Color Choices
Wo~Wrap

Wh~her text is in a Placeholder or a textbox, you can narrow or widen the width of the box
by dragging the box border. This affects where the text wraps. Make sure the cursor looks
like ill two-headed arrow to affect the Placeholder width; a four-headed arrow will move the
placeholder,

9.2. Drawing Objects:

I" .._•• ~o draw a line, an arrow, a square, or a circle, select the appropriate tool
from ~heDrawing Toolbar. When you move the cursor over the slide, it will be a crosshair.
Pres, and drag the cursor to insert the object. The larger an area you drag, the larger the
object will become.

TIP: To draw a straight line or arrow, or a perfect square or circle, hold SHIFT as you
press and drag.

Sele~ting
To alter any PowerPoint object, you first must select the object. When you click the object,
you will see Handles around the perimeter of the object. This lets you know exactly which
object you will be affecting.
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Sample Handles

Deleting
To delete an object, click to select it, then press DELETE.

Fill Colors
When you draw solid objects (squares and circles), they fill with the automatic color. The
underline under the Paintbucket is the current fill color.

I ~ I To fill an object with the current fill color, select the object, then click the
Paintbucket Tool.

To change the current fill color, drop down the arrow beside the Paintbucket and make a
new selection. There are also additional options under Fill Effects, including choosing no
fill color at all.

Additional co you
may have chosen in
this presentati on

Automatic Fill
Color

Alternate Choices for Fill Colors

Fill Effects
Fill effects include Gradients where you can select one or two colors of your choice, as
well as the direction and variants of the gradient. Textures are image files similar to web
page wallpapers; you can use PowerPoint's selections or choose an image file from your
workstation. Patterns allow you to choose two colors and the pattern design with which
you want to fill the object. Picture allows you to choose an image file from your
workstation; the photograph will center itself within the selected object, hiding any parts of
the image, which do not automatically show within the object's shape.
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Patterns

Photos
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Lin~ Effects

I.e; il Each drawing object has an outline the color of the automatic color. The underline
under the Line Color Tool is the current line color. To outline an object with the current line
colqr, select the object, then click the Line Color Tool.

To ~hange the line color, drop down the arrow and make a new selection. Other options
with!the Line Color Tool include color and patterns similar to the Fill Tool.

I== .~ E I To change line style, dash style, and arrow style, click on these tools,
respectively, after drawing the object and while it is still selected.

I- it~o place a shadow or 3D effect on an object, select the object, then click the tool
seleetion.

Aut~Shapes and WordArt

If yo,,'re not particularly artistic, AutoShapes andWordArt can come to the rescue. To use
AutoShapes,

. 1. From the Drawing Toolbar, click the drop-down arrow beside AutoShapes, and
then select the shape type.

I 2. Click the shape you want. The cursor will change to a cross-hair as you move
the mouse across the slide.

3. Click on the slide where you want to place the shape.

4. Move the object, change its size or color, as desired.

Autoshapes Tool
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~o use WordArt,
1. Click the WordArt Tool.

2. From the WordArt Gallery, click the design you want, then click OK.

WordArt Gallery
3. In the Edit WordArt Text box, type your text. You can also change the font face

and type size, or add bold or italics. Then click OK.

The art will be placed in the center of the slide and is always smaller than you would
like-press and drag the handles to enlarge the object to the desired size.

Many of the WordArts also have one or more small yellow diamond-shaped handles. You
can press and drag any of these to distort the shape of the object:

Samples of Word Art

To change the colors in WordArt, make sure the object is selected, then choose FORMAT:
WordArt and make your selections.
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Te)CtTool

l(jjJiTo insert text on the slide other than in a Placeholder

1. Click the Text Tool.

2. Press and drag the cursor over the slide to create a Text Box.

3. Type in the box.

NOTE: Any text you type in a placeholder will show in Outline View; text inserted via the
Text Tool is treated as an object and will not display in the outline.

Moving
To move an object on the slide, select it, then move the cursor over the object until you
see the four-headed arrow along with the cursor. Press and drag the object to the location
you need it.

NOTE: Be sure it is a four-headed arrow rather than a two-headed arrow. Two-headed
arrows re-size objects.
To move a text box, select it, then move the cursor over the frame until you see the four­
headed arrow along with the cursor. Press and drag the text box to the location you need
it. If you move the cursor within the box, it will change to an insertion point so that you can
type or edit text.

Rotating

rotate any object, including a text box,

1. Click the Rotate Tool.

2. Click the object to be rotated.

3. You will see small green disks in place of the normal handles on the object.

Sample Rotated Text
4. As you move the cursor over the disk, it will change to a looped circle. Position

the loop over one of the green disks and press and drag to the desired rotation.
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5. Click the Rotate Tool to deselect it.

Grouping and Ungrouping
Often after you have created multiple objects and layered them in the sequence you need,
you want them to "stay put". By grouping multiple objects, you can move or resize them as
a single entity rather than manipulating their individual components.

To group multiple objects:

1. Size each individual object as necessary.

2. Layer objects as necessary.

3. Each object must be selected prior to grouping. To select multiple objects, hold
SHIFT then click each object. Each object clicked becomes selected and the
handles of each are displayed. Release SHIFT after you have selected each of
the objects to be grouped.

4. From the Drawing Toolbar, choose DRAW: Group. You will see that the objects'
individual handle-sets will be combined, leaving a single handle-set for the
grouped object.

Sometimes, if your object is very complex, you will find it beneficial to group your object
components incrementally. When you finish a subset of your final object, group the
components you have finished. Then you can continue building additional components,
knowing you won't accidentally move or re-size the portion you have completed.

Text that you include in a grouped object will not change point size if you re-size the
grouped object, however, word-wrapping may adjust to conform to the re-sizing.

To manipulate individual components of grouped objects, you must ungroup them. To
ungroup an object, select it, then from the Drawing Toolbar, choose DRAW: Ungroup.
After editing, you can choose Re-group.

9.3. Images and Clip Art:

PowerPoint comes with a library of "clip art" that includes traditional clip art, as well as
videos, photographs, and sounds. You can also insert graphics from other sources into a
presentation.

IIII IToaccess PowerPoint's ClipArt Gallery, click the ClipArt Gallery Tool (located on
the Drawing Toolbar).

To use a Gallery ClipArt image, in the Insert ClipArt dialog box, select the category
pertaining to the type of image you are looking for, then select the image you want. A pop­
up box will allow you to: insert the image, preview the clip, add the clip to a different
category, and/or find similar clips.
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Insert ClipArt Dialog Box

The greatest benefit of the ClipArt Gallery is that you can add multiple selections to your
presentation without leaving the Gallery.

ClipArt images will be inserted in the center of the slide. You can move, enlarge, or reduce
them.

, To select multiple objects using the mouse,

1. Position your mouse cursor beyond the corner of the object to be re-grouped.
Make sure you start far enough beyond the objects to catch all of the
components.

2. Press and drag diagonally across the objects to select all the components. Make
sure that you do not accidentally include an object in the selection that you do
not want to be selected. (You may have to try this step several times, it is a bit
tricky to master.)

3. After all the components are selected, from the Drawing Toolbar, choose DRAW
: Group (or Regroup).

9.4. Audio and Video:
Your presentation can link to external audio and video files.

• Select the slide on which you wish to add a link to an audio or video file.

• On the Insert menu, point to Movies and Sounds.
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• To insert a sound from a file, click Sound from File. To insert a video from a file,
click Movie from File.

• A standard file directory window appears.

• Locate the folder that contains the audio/video file you want, and then double-click
the filename.
Note: In PowerPoint, by default your movie or sound will play manually. If you
want it to play automatically you will have to set Custom Animation options for the
slide.

• For audio files, a sound icon '41 appears on the slide.

For movies, an image consisting of the first frame is displayed as a placeholder.•
• To preview the audio/video in Normal view, double-click its icon.

Note: Alternatively, you may have to use the Insert I Object command since PowerPoint
is not able to play all audio/video formats inline. Insert I Object will open the media
element in a new window rather than making it appear embedded on the slide, and it will
be played by an external program.

9.5. Creating Hyperlinks:
Hyperlinks cause the selection of an object to result in a move to a new location or the
performance of an action. You can create your own object or choose an AutoShape Action
button.

To link an object with an action, select the object, then choose SLIDE SHOW: Action
Settings.

In the Action Settings dialog box, choose either Mouse Click or Mouse Over. Then select
the button "Hyperlink to" then select the destination or action. You can also choose to play
a built-in PowerPoint sound this action and/or to the object as you click it.
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9.61Animating the Presentation:

To imate a single object on a PowerPoint slide

1. Select the object.

2. Choose SLIDe SHOW: Preset Animation.

3. Select the animation effect you desire for the selected object.

Preset Animation Dialog Box

Anim*ed Layers or Slides
You .. y find it useful to bring a layered object into a presentation one layer at a time,
buildi it on-screen. To animate a layered object or to animate each object on a slide

11. Choose SLIDE SHOW: Custom Animation. (You must be in Normal, Outline, or
1 Slide View.)
!
;

~. In the Custom Animation dialog box, each object is identified in the Check to
j animate slide objects list.

If you don't remember what a particular object is, click the object's name in the
list; that object appears selected in the preview window.

~Ii Click in the object's checkbox to animate that object. It will be added to the
Animation order list.
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4. To change the order that the animated objects appear, select the object in the
Animation order list, then click the up or down arrow to move the object through
the list.

5. Choose whether the object appears only on a mouse click or after a specified
number of seconds.

2. Pictureframe 4
3. Pictureframe 6
4. Text 3
5. Pictureframe 7
6. Pictureframe 5
7. Pictureframe 1

Layer Animation Dialog Box

To choose other effects such as sound effects and how the object appears on the slide
during the on-screen presentation, click on the Effects tab.

2. In the Introduce Text section, from the drop-down box, choose whether the text
is introduced all at once, by word, or by letter.

To animate text,

1. Click on the Effects tab.

To animate charts click the Chart Effects tab. You can choose to introduce the data by
series, categories, or elements.

NOTE: Be careful of using too many effects in any single presentation because they soon
become detraction to rather than an enhancement of the presentation.

9.7. Slide Miniature:
When you have zoomed the view of your slide so that all of the slide cannot be seen on
the screen at one time, PowerPoint will create a black and white Slide Miniature in the
corner. This allows you see the overall effects of the changes you are making to the slide.

•
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• Fourth of July
• Memorial Day
• New Year's Day

Holiday

--r- .. \. .../.'.\~-~
• Christmas

Sample Slide Miniature

You may also choose to work in black and white mode by choosing VIEW: Black and
White. To see a small color view of the current slide when you are working in black and
white, choose VIEW: Slide Miniature.

9.8.Slide Transitions:
Transitions determine the effects applied when you move from one slide to another

during an on-screen presentation. You must be in Slide Sorter View to access the
Transjtion Toolbar.

To choose only a transition effect, click the dropdown box beside the words "No
Transition" and select a transition. To have other transition choices available to you, click
the Slide Transition Tool.

Sample Transition Tool and Drop-down Box

When you click the Slide Transition Tool, the Slide Transition dialog box allows you to
choose not only a transition effect from a drop-down box, but also offers other choices that
affect your on-screen presentation.
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Sample Transition Dialog Box

TIP: Do not use a different transition on each slide because your audience attention
should remain focused on you and the content, not the effects. If you want to use multiple
transitions, a good rule of thumb is to apply a unique transition to each slide in a specific
module of the presentation.

Generally, you should leave the Effect Speed set to Fast. This brings in the next content
slide quickly and keeps your audience's attention focused on the presentation content.

PowerPoint contains a few built-in sounds. To playa sound as the slide is transitioning,
make a sound selection from the Sound drop-down box. Unless you have a well thought
out reason for doing so, do not choose to have the sound loop until the next sound; it can
become annoying very fast while you are giving a presentation, as well as making it
difficult for you to speak over. Also, many presentation locations do not have adequate
speakers attached to the computer to allow all of your audience to hear the sound.

• In Slide or Slide Sorter view, select the slide or slides on which you want to add a
transition.

• Repeat the process for each slide you want to add
a transition to.

• On the Slide Show menu, click Slide Transition.

• From the Effect drop-down list, click the transition
you want.

• Select any other options you want (speed
Slow/Medium/Fast, Advance on mouse Click or
Automatically, Sound or No Sound)

• To apply the transition to the selected slide, click
Apply. To apply the transition to all the slides, click
Apply to All.

Ii



uter Based Documentation 9.17 Microsoft PowerPoin
,t To view the transitions, on the Slide Show menu, click Animation Preview.

9.~.Slide Show Animation:

, You can control how and when text, graphics, and other objects appear on your
po~erpOint slides. For example, you can make graphics or text items appear one at a time
and add visual or sound effects. Animation can aid in focusing attention during a
pres entation and make your slide show more interesting. To set slide show animation
opti ns, display the slide that has the objects you want to animate, then on the Slide
Shqw menu, click Custom Animation.
Timfl9 Tab

.: In PowerPoint, ensure that you are on the Timing tab.

• Under Slide objects without animation, double-click the objects you want to
animate.
(they should be moved up to the Animation Order box).

• Use the up and down arrows to the right of Animation Order to change the
sequence in which objects will appear (move objects up or down in the list).

• Under Start Animation set the timing (when objects will appear). Select each
object and then do one of the following:

o To start the animation by clicking the object, select the On mouse click
option.
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o To start the animation automatically, select the Automatically option, and
fhen enter the number of seconds you want to have elapse since the
previous animation.

Effects Tab

• Click the Effects ta'6to set options for

• Under Entry animation and sound select t6e options you want.

• To preview the animation effects, click the Pfevlew button.

• In the example above, the object will enter tbe screen with a Spiral animation and
the Chime sound will play. ..

Animating a text box containing bulleted text

• On the Order & Timing tab, the text box is selected with a check mark, and the On
mouse click option is chosen (to let the presenter control the slide show with
mouse clicks).

j
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• On the Effects tab, the options set below will make each line of text enter the
screen with a Fly From Left animation, No sound will play, and when the next
line of text appears the previous line will change to a lighter color (a dimming
effect). To preview the animation effects, click the Preview button.

The series of images below show what the screen looks like after each mouse click when
the slide with the bullated text (set with options as above) is displayed during a Slide
Show. Notes that the previous text points are dimmed as each subsequent line appears.

(



jAcharya NagaIjuna University 9.20 Centre for Distance Educatioij

9.10. Rehearse Timings:

The Rehearse Timing Tool allows you to practice giving an on-screen presentation,
regardless of any slide advance timings you may have set previously. The tool sets time
not only for the entire presentation, but also each individual slide, as you rehearse. Each
time you advance the slide, the time is recorded. You must be in Slide Sorter View to
access the Rehearse Timing Tool.

Total Time
Time per for
Slide presentation

Next Pause
Slide

Repeat
Rehearsal of
this Slide

Sample Recorded Rehearsal Timings

~ To use the Rehearse Timing Tool, click the Rehearse Timing Tool.
When you have completed rehearsing, PowerPoint displays the total time for the
rehearsed presentation and asks if you want to record the new timings. If you click "Yes",
these new timings will replace any slide advance timings you may have previously set for
the presentation.

Sample New Timings Dialog Box

Before you print your slide presentation, make sure the slide size and orientation is
correct. Also, decide whether you want to print in color or black and white.

Change these settings using the Page Setup and Print commands on the File menu.

Slide Setup
The Slide Setup dialog box has controls for slide size and orientation. Choose the
appropriate slide size and orientation before you do significant formatting in your
presentation. Changing slide orientation from portrait to landscape or vice versa may
require editing and reformatting slides.

\
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Pri._ting
To print your slide presentation, choose Print from the File menu, or click the Print button
on .,e toolbar. In the Print dialog box you can choose how many copies you want to print.
Use the Print What: drop-down list to select whether you want to print just the slides,
notes, or handouts with multiple slides per page.

9.1~.Charts:

To if'lsert an organization chart (depicts hierarchical relationships):
• First display the slide on which you want the chart to appear.

• On the Insert menu, point to Picture, and then click Organization Chart.

• A separate Microsoft Organization Chart window appears.

• Use the buttons at the top of the Organization Chart window to add text boxes to
your chart (above, below, or beside existing boxes).

• Click your mouse inside a box to edit the text inside of it.

• As shown in the example below, you can use this type of chart for almost any type
of information you want, not just managers, workers, and other positions within a
company.

To aeate a bar or pie chart (or similar chart based on numbers in a datasheet):
tI First display the slide on which you want the chart to appear.

• On the Insert menu, click Chart - or click the Insert Chart button on the
PowerPoint toolbar. •

• A sample chart and datasheet (spreadsheet) appear on the screen as shown
below.

• To replace the sample data, click a cell on the datasheet, and then type the
information you want.

,
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• To change the chart type, on the Chart menu, click
Chart Type. In the Chart Type window, which
appears, click on the desired Chart type and sub­
type and then click the OK button.

90".-----...----,
1Oll-----i 1----1
1(11+----1 I----l

• To return to PowerPoint, where you can move and
size the chart, click outside the chart on the
PowerPoint slide.

• If you wish to re-edit the chart, double-click the
chart on the PowerPoint slide.

9.13. Summary:
At the end of this lesson you have learnt how to insert and format text, working with the
pictures and inserting images into a slide. The concept of Slide transition, Slide
animation, Rehearse timings allows you to automatically move to next slide without
manual interaction. A layman can also know more about the data results with the help of
charts.

9.14. Technical Terms:
Hyperlink: Hyperlinks cause the selection of an object to result in a move to a new
location or the performance of an action.

Slide Transition: Slide Transition determine the effects applied when you move from
one slide to another during an on-screen presentation.

Slide Show Animation: Slide Show Animation can aid in focusing attention during a
presentation and make your slide show more interesting.

Rehearse Timings: The Rehearse Timing Tool allows you to practice giving an on­
screen presentation, regardless of any slide advance timings you may have set
previously.

Slide Setup: The Slide Setup controls for slide size and orientation.

9.15. Model Questions:
1. Explain the procedure to draw the objects in PowerPoint?

2. Define Hyperlink? Explain the procedure to create Hyperlinks in PowerPoint?

3. What is a Slide Miniature?

4. Define Rehearse Timing? Explain the procedure to set the rehearse timings to
slides?
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RCom. DEGRgE EXAMINATION,DECEMBER ~()10.

(Examination at the end of SecondYear)

Part Il- Commerce

Paper II - COMPUTERBASEDDOCUMENTATION
ime : Three hours Maximum: 100 mal ks

PARTA - (3 x 20 = 60marks)

Answer any THREE questions.

Explain paragraph indentation and Bonders and Shading feature to paragraphs.

rS'~6>~6dW ~o1\ ~~6>~ ~6o'S.>J~O"L~~!!llll~~ ~~6~.

I. What are Headers and IC'ooters?How do you create them? How do you sot alternate Houdcrs
and Footers?

l gxplain!

(11) Insert table and

'tD.5~ai3wt5' ~dUJ

(b) 'fable properties diulog boxes.

C~ L;bI~~~V"';~..)a> :>~6~~,

What are the main components of a Mail Merge? Explain Mail Merge process.

'~~a dh>~L-~~ eo:irW ~~?~Q)J&>aL~~ ~~6~~.

(8) Auto content Wizard

(b) Five PowerPoint views.

gxplain adding graphics and text effects to presentations.



PART B - (5 x 6 = 30 marks)

Answer any FIVE questions.

7. Describe the various clements orWordApplicationWindow.

'~ae~l~ ::Jof1.Qh)~lTe~~e~·~~.
1

8. . Explain Print Dialog Box.

'L:'OtlJ ~v-1\~J'~ ::J~6~~.

9. Explain the stepe to create a new temple. How do you convert an existing document into a
template?

,
10. Explain the uses of different tabs.

11. What is a rnacro? How do you create it?

12. Explain 'Slide master'.

13. Explain animations and transitions feat~re.

. PART C - (5 x 2 = 10marks)

Answer any FIVE queatiol1l.

14. What is the difference between 'save' and 'save as'?·

'Save' ~dW 'save as' e ~4lltQ'" ~~?

15. Write Keycombinations to select:

(a) Beginning of a line.

~~ Qb)~lTtt~ tu8o.'W-

(b) End of a paragraph.

~C-L""~Qh)~b:I~tSel) ~:,~ ~~~~llls-oe:,~t~ ~~.

2



lEt Describe rnagnitlcsi'button.

18.. What arc the wrable Propertiel'?

~~. ~"'•., ~D? .

19. List the' components in the colour acheme dialog box.

~e>~ !,~ ~o-f\~6'~ eOlrC) ~~.

20. What is the Cunction of 'Change All' option in the Spelling Dialog Box?•
'~J~o1{~K ~'6'~ 'Change All' e!J~ ~b- ~~? •



a.Com. D~G:REEEXAMINATION. DECEMBER 2011.

(Examination at the end of Second Year)

.... Commerce.
Paper 11- COMPU1'ER BASED DOCUMENTATION
Time: Three hours Maximum: 100 marks

PART A - (3 x 20 = 60 marks)

Answer any THREE questions.

1. Explain the Text formatting facilities in MS·Word.
,

MS-Word 6' Text Formatting facilities t'{)8o~

~o~.

2. ~xplai!l the advantago. or Word pft')Ctsitsing.

Word processing c5i>Jgtr s~cSlJ-1N:).) C\t).)o~.

3. Explain "Insert Menu" in MS·Word.

MS-Word 6' Insert Menu ~8~ t?dS..>o~.'

4. Describe the different - views in MS·Power Point.

MS-Power Point 6' different - views X1-8.)

l?"dS..>oa.

"

..



5. Kxplail1 the U8U ot Auw context Wizard in
MS·Power Point With example.

MS·Powor Point {jt Auto context Wizard ~b­
a~®-Xo t\eJ.)oa,.rJ"~tSn4t :l~~o&.

o. lilxplain about '~FilaMonu" ill MS.Word.

MS.·Worde5''li'ilc M:enu XJ96.)~&.

PAR'T B ~. (5 x 6 :::30 marks) ..
Answor any ,lt11VE. questiom••

7. .Describe the various parts in MS·PowerPoint.

MS·Powcr Point :Joe dhJ~u ~~ !):J.)?

"S. Mnil Mergo US" in MS,Word.

M:S.Word iJ'Mail M~~ge dhJ!tb-$::5.~".~ i)e>.)o~•

..

.9. '.~~xplainEdit menu in MS,Word.

MS·Word 6' Edit menu K1-6j t\e>J9.c!'.

to. ltXpllliu the foUowillg :

lloa :7-tS t'U6o:> ~.

(e) .Sp611ing and Grammar
"(b) Adding a Table to.a Document.

2 (DBC 25)



11. l~xplaill how a document i.printer in MS-Word.

MS-Word 6' document o !) :»l;Son-print ~d1>Xee

~~6o~oa.

12. l~xplait1Advantttgeit of MS·P()w~r Point.

MS-Power Point ~~o- ~~dlJ-n-el.) ~~.
13. ~xplain tho use of Auto tormat feature. ot

MS-Word.

MS-Word 6' Auto format Q1)J~lT.~c»J-n-m x.,.6.)

~od..

PART C - (5 x 2 = 10 marks)

Answer any FIVE questions.

14. Save,Saveas.

15. Gut, Copy, Paatu.

~tS,s-:', !>~.

16. Bullets and Numbering.

w~tUjJ8dW ~o8J6oK
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1'1. Clip Art.

!~u~
1M. Dtllwiilglfymbolaa ill Me-Word.

MS·Word Drawing symbols K>8C>l:)~.

11), AnliflobtiuH.

e~tu~.

20.. }'IageIlteak.

~l t.Z11.

"
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